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Introduction 
Congratulations on the purchase of your new F-900 Portable Ethylene Gas Analyzer. The F-900 

provides accurate real-time measurement of ethylene gas concentrations in a compact instrument 

suitable for field and laboratory use. At the core of the instrument is an electrochemical sensor that 

offers extraordinary sensitivity to ethylene, at levels as low as 0.025 ppm (25 ppb) in air. 

Ethylene production is known to increase in response to plant stress and during fruit ripening and 

maturity, and until recently, sensitive ethylene measurements were available only through 

elaborate and expensive gas sampling and gas chromatography analysis. The intent of the F-900’s 

portable design is to aid the research community in developing real-world ethylene management 

applications for the benefit of growers, processors, and consumers.  

The F-900 employs electrochemical sensors as well as several other sensors for temperature, 

humidity, GPS location, and optionally carbon dioxide (CO2: high and low range) and oxygen (O2). 

During a sample, the subject gas travels across the surface of the electrode and diffuses into the 

electrochemical cell where ethylene is oxidized. The current created by the oxidation is measured 

and interpreted as the concentration of ethylene (reported in parts per million or ppm).  

We hope you enjoy using your F-900 Portable Ethylene Gas Analyzer. 

 

Figure 1: The F-900 Portable Ethylene Analyzer front panel and display. 
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Features 

 High sensitivity to C2H4 (0 ppm – 200 ppm)  

 CO2 and O2 sensing capability (optional) 

 Compact portable form factor (2.96 kg) 

 Real time continuous monitoring 

 Internal data logging and storage  

 Automatic data logging with adjustable interval 

 User adjustable flow rate 

 Transflective display enables easy viewing in direct sunlight 

 Rechargeable Li-Ion battery provides 5 hours of monitoring in the field 

 Multiple configurations to accommodate in situ research and controlled atmosphere 
monitoring  

 Instantaneous and accumulated measurement modes (Monitor and Graph View) 

 Quick connect sampling ports 

 Data saves in .csv (commas separated value) file 

 Configured for domestic and international operation: 110 VAC, 60 Hz or 230 VAC, 50 Hz 

 Non-destructive measurements 

 Mini-USB chargeable and mini-USB data download 

 Time-date stamped data records 

 External wire terminals for fixed location monitoring or control applications 

 GC Emulation Mode for small sample volumes ranging 0.8 – 20 ppm C2H4 (optional) 

 

 
Figure 2: The removable SD card on the F-900 makes data transfer quick and simple. 
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Specifications 
 

F-900 Specifications 
Display Sunlight visible transflective graphic LCD 

Operating environment 0°C - 45°C (0-90% humidity non-condensing) 

Battery Capacity 5-8 hours - Rechargeable Li-Ion (5000 mAh) 

Dimensions 183.5mm x 111 mm x 120 mm 

Weight 2.96  kg 

Enclosure Anodized aluminum 

Typical air Sampling Rate 80 mL/min 

Measuring Rate 1 second intervals, open or closed loop 

Warm-up time 1 minute 

  

C2H4 PPB Sensor  Electrochemical 

Nominal Range 0- 10 ppm 

Resolution 0.001 ppm 

Lower Detection Limit 0.025 ppm (25 ppb) 

Accuracy 5% ± 25 ppb 

Offset Recalibration Weekly 

Span Recalibration *3 months (calibration gas required) 

  

C2H4 PPM Sensor Electrochemical 

Nominal Range 0- 200 ppm 

Resolution 0.1 ppm 

Lower Detection Limit 0.5 ppm  

Accuracy ±5 % ±0.5 ppm 

Offset Recalibration weekly 

Span Recalibration *3 months (calibration gas required) 
 

*typically < 5% drift/month 

GC Emulation Mode Specifications 
C2H4 Range 0.8-20 ppm 

Accuracy ±10 % 

Minimum Sample Volume 5 mL 
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  Optional Sensors 
CO2 PPM Sensor  Low-Power Non-Dispersive Infrared Gas Analyzer 

Chopping Frequency 1Hz 

Source Life 5000 Hours 

Nominal Range 1 – 2000 ppm (Standard) 

Resolution 0.1 ppm 

Repeatability ±0.1 ppm (short term) 

Accuracy 5% 

Sample Cell 100 mm x 10.2 mm (3.94" x 0.4" diameter) 

Warm-up time <3 minutes 

Weight 172.6 g 

Offset Recalibration Weekly 

Span Recalibration 6 months (calibration gas required) 

  

CO2 Percent Sensor  Infrared Sensor, Pyroelectric detector 

Nominal Range 0 – 20%  

Resolution   0.01% 

Accuracy 5%  

Offset recalibration 6 months 

Span recalibration 6 months (calibration gas required) 

Lifetime  >5 years 

Warm-up time <3 minutes 

Weight 7 g 

  

O2 Percent Sensor  Electrochemical 

Nominal Range 0-100% 

Resolution 0.1% 

Offset recalibration 6 months 

Span recalibration 6 months (calibration gas required) 

Operating environment 0°C - 55°C (5-95% humidity non-condensing) 

Weight 7 g 
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Warnings 
 Read this manual carefully before using: this manual should be read by anyone who will be 

operating the F-900. By following the guidelines, the F-900 will function according to the 

specifications in this instruction manual.  

 All repairs should be performed by a Felix Instruments technician. 

 The analyzer must be used to measure the rate of ethylene in the presence of nitrogen, 

oxygen and carbon dioxide. All other gases in high concentration could lead to erroneous 

measurements, or the destruction of the sensor. Do not use the instrument in the presence 

high concentrations of aromatic solvents, hydrocarbons or other volatile organic 

compounds, such as in unventilated painting rooms or chemical storage rooms.  

 Damage to the analyzer can occur if the fluid reservoir level is too low or if the inlet and 

outlet gas connections are blocked while the pump operates. This can cause false readings 

or irreparable damage to the sensor.  

 Use a T-valve when connecting the F-900 to a standard gas tank 

 If smoke comes out of the analyzer, turn off the power immediately and contact Felix 

Instruments-Applied Food Science. 

 Keep the analyzer in a clean and ventilated room at ambient temperature.  

 Do not allow fluid to aspirate in the analyzer, which can destroy the sensors. 

 Do not use the F-900 in a high RF (radio frequency) environment. High RF will disrupt the 

F-900.  

 ESD (electrostatic discharge) interferes with the F-900 measurement data. 

 Do not tilt the F-900 when Chamber IN contains water 

 Do not fill Chamber IN beyond max fill line 

 WARNING: Do not store the F-900 without charged batteries! The internal batteries 

must have charge to maintain the accuracy of the sensors, even when the unit is 

powered off.  It is recommended to keep the instrument connected to the power 

supply for long term storage.    

 

The analyzer has a reservoir containing 1 mol of sulfuric acid (2N H2SO4). Avoid 

contact with skin and eyes. If contact occurs, rinse thoroughly with water or use 

an eyewash or safety shower. Do not drink the contents of the fluid reservoirs as 

it could cause chemical burns. See Appendix I for the safety data sheet and 

further information on sulfuric acid.  
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Theory of Operation 
The ethylene sensors in the F-900 are electrochemical. With this type of sensor, the gas sample 

travels across the surface of the electrode and diffuses into the electrochemical cell where ethylene 

is oxidized. The current created by the oxidation is measured and converted to parts per million 

(ppm) of ethylene.  

 

 

 

 

 

 

 

 

 

Figure 3: Diagram of an electrochemical sensor. (A) working electrode (R) reference 

electrode (C) counter electrode (E) electrolyte. Image credit: doi:10.1093/aob/mcs259. 

 

The F-900 flow rate is regulated by a pump and a flow meter. Additional optional sensors are 

enabled/disabled in the Setup Menu (see page 40), as well as “conditioning chambers” on the back 

of the instrument (see page 45). 

The temperature and relative humidity sensors are located inside the instrument. Therefore, the 

temperature sensor is subject to heating by the F-900 internal electronics. The temperature reading 

is often 4-5OC above ambient and in turn, relative humidity readings are affected. The use of water 

in Chamber In (PolarCept, see page 8), will also affect relative humidity readings.  
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Figure 4: Flow path diagram of the F-900 ethylene analyzer. Dashed line indicates optional 

flow path capabilities.  

 

Interfering Gases 
No analytical method is completely specific. Gases present in the environment, other than the target 

gas of a measurement, may affect instrument response. Interferences are not necessarily linear, and 

may also exhibit time dependent characteristics. 

Ripening fruit emits a complex mixture of hydrocarbons, including ethylene. Oxidation of these 

other gases in the electrochemical sensor cannot be readily distinguished from ethylene. This 

causes the ethylene value to be falsely high in the presence of interfering gas. Felix Instruments has 

tested a method to absorb some of the competing gases and provide better ethylene measurements. 

This method, PolarCept, uses distilled water in conditioning Chamber In and has been shown to 

filter out alcohols and produce less interference.  
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PolarCept 
PolarCept is the use of distilled water in conditioning Chamber In to filter out or trap some of the 

interfering gases. Gas from the sample environment is passed through the water trap. Some of the 

polar molecules are held in the trap, while ethylene passes through the water trap to the sensor, 

where oxidation occurs. CO2 is released as the oxidation product from the sensor. The water being 

used can become saturated after several minutes, so it must be cleaned of the trapped interfering 

gas molecules. Trapped interfering gases are driven out of the water during the cleaning time by a 

concentration gradient.  

It is recommended to always use the PolarCept filter when measuring a gas mixture or 

interfering gases present will be reported by the instrument.  

Alcohols can induce a baseline shift and/or change the sensitivity of the ethylene sensor. To recover 

the sensor after exposing it to alcohols, run it with clean air for a few days.  
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PolarCept: Measure 

 

 

 

 

Regeneration: cleans the waeter 

 

PolarCept: Clean 

 

 

 

 

 

 

 

 

 

Figure 5: Top: diagram of measure period during use of PolarCept. Bottom: diagram of 

cleaning period of PolarCept.  

  



F-900 Instruction Manual 5/8/2017 

1554 NE 3rd Ave, Camas, WA 98607, USA                   Phone: (360) 833-8835 10 
sales@felixinstruments.com                                         www.felixinstruments.com 

Unpacking the F-900  
The F-900 base unit arrives with the F-900 and several accessory parts to use with the instrument. 

Included are the heavy duty USB cable, charger, tubing accessory kit, potassium permanganate 

(KMnO4) and an F-900 Instruction Manual. Several different styles of connector pieces and various 

lengths of tubing that do not outgas (ex: Viton or Teflon) are provided as part of the tubing 

accessory kit. Male and female quick connectors can be added to tubing and used to connect sample 

bags or custom chambers to the F-900.  

  
Figure 6: Accessories and parts that arrive with the F-900, clockwise from top center: F-900 

ethylene analyzer, power supply and heavy duty USB cable, Viton tubing, Teflon tubing with 

quick connects, assorted quick connects. 

 

The F-900 includes the consumable potassium permanganate (KMnO4), which is used to scrub 

ethylene and other hydrocarbons from the gas stream. If the instrument has an optional CO2 sensor, 

soda lime is included, which is used to scrub carbon dioxide from the gas stream and to create a 0 

ppm CO2 gas for the CO2 zero calibration.  
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F-900 Research Kit Accessories 
The F-900 Research Kit (F-900RK) includes parts to non-destructively sample fruit in the field or 

laboratory. The F-900RK arrives in a hard-sided carrying case with a fruit chamber and wand with 

flexible tubing to sample fruit or plants. The fruit chamber includes a closed chamber lid and a lid 

with a seal to allow sampling of fruit still intact on the plant. The F-900RK includes all the parts and 

accessories that arrive with the F-900, as well as an external conditioning tube, sample bag, 

injection port assembly, glass syringe, needle, and a jar of silica gel which can be used to dehumidify 

the gas.  

For information on the 8L fruit chamber, please see appendix IV. 

 

 

Figure 7: The F-900RK arrives with a fruit chamber and two lids: closed chamber lid (left) 

and slit chamber lid (right).  
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Operating Instructions 
To turn the instrument on, press the green power button. The top of the display reads F-900 and 

the current firmware version the unit is running. For information on the latest firmware version, 

please visit the F-900 software webpage (http://felixinstruments.com/support/f-900-support). 

Below this, a menu will appear on the display with the following options: Measure, Setup, View and 

File. This is the F-900 Main Menu. After the instrument is powered on, the uptime and battery life 

remaining will be displayed on the bottom line. The uptime, or time the instrument has been 

powered on, is displayed in hours: minutes, followed by the battery life in percent. 

Note: If the F-900 does not power on, eject the SD card or disconnect the mini-USB cable from the 

front of the instrument. Then, power the F-900 on. Re-insert the SD card or reconnect the charger. 

 
Figure 8: The options on the Main Menu of the F-900. 

 

Use the up and down arrows to switch between menu options and the right arrow to select. Press 

the green power button to power off the F-900. 

 

Note: To force a power off and reset of the F-900 at any point, press and hold the power button 

for 10 seconds. This “emergency hard shut-down” feature exists to address hardware or software 

problems and should not be used except when needed.  

http://felixinstruments.com/support/f-900-support
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Charging the Internal Battery 
The F-900 arrives with a wall charger that can be used to recharge the F-900 battery, as well as for 

continually powering the unit during long-term monitoring. To charge the F-900: 

 Connect the mini-USB cable to the front panel of the F-900 

 Plug the charger into the wall 

 Check the charge status (on/off) at the “View>Battery” menu 

 

Figure 9: The battery charger setup of the F-900. 
 

The display will flash “powering off” on the top line when you hit the power key. For fastest 

charging of the F-900, use the highest rated port on the charger and do not connect any other 

USB devices to the charger.  

To use the F-900 in Monitor Mode to continuously monitor fruit storage rooms or other locations, 

or to run the instrument for days or weeks at a time, connect the mini-USB cable to the charger 

cable and to the connection port on the front panel. Plug the charger into an electricity source.  

WARNING: Do not store the F-900 without charged batteries! The internal batteries must 

have charge to maintain the accuracy of the sensors, even when the unit is powered off. Keep 

the instrument connected to the power supply for long term storage.    
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F-900 CO2 PPM Sensor and Battery Power 

The CO2 PPM sensor will draw power when turned on, even if the F-900 is not actively measuring. If 

trying to conserve battery life, the sensor should be turned off when not being used.  

 Always turn the CO2 PPM sensor to “off” for the fastest recharge, either using the mini-USB 
cable and computer or with a wall charger.  

 The CO2 PPM sensor ranges from 0-2000 ppm. The CO2 PCT sensor is from 0-20% and does 
not have the same power draw.  

 

To turn off/on the CO2 PPM sensor: 

1. Go to Setup>Sensor>Sensor Selection. 

2. When asked “Are you sure you want to continue?” press Enter. 

3. Press the down arrow to highlight CO2 PPM. 

4. Press the right arrow key to highlight On/Off.  

5. Press the up/down arrow key to toggle On/Off the sensor. 

6. Press Save when the desired setting is highlighted. This will turn off the CO2 sensor until 

you come back to this menu and turn it back on. 

7. If you press Enter, the CO2 sensor setting will only be temporarily saved. When the 

instrument is turned off and then back on, the CO2 sensor will be enabled.  

 

 

  

Setup Sensor 

 

C2H4 PPB          On 

C2H4 PPM         On 

CO2 PPM            Off 

CO2 PCT             Off 

O2                        Off 
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Measure Menu: Taking a Measurement 
To begin taking measurements, select the Measure menu option by pressing the right arrow when 

Measure is highlighted on the main menu display. Make sure the IN and OUT ports on the front 

panel of the instrument are clear from any obstructions. Create and open a file before starting a 

measurement, otherwise the default filename on the SD card is File01.  

If sampling ambient air, turn the unit on and leave the front ports free of obstruction. If sampling a 

container or pallet, connect the Viton tubing to the IN port and place the end of the tubing into the 

container or pallet to be sampled. If using the F-900RK, place the fruit to be sampled in the fruit 

chamber, and connect it to the IN port on the unit. It is up to the specific setup whether the OUT 

tubing is connected to the OUT port with Chamber Out filled with potassium permanganate 

(KMnO4) and set to “on”. If left disconnected from the OUT port, the fruit chamber is allowed to 

replenish with ambient air.  

Sensor Stability 
The F-900 will begin to warm-up. The F-900 will display the “Sensor Stability” screen after pressing 

the RIGHT arrow to get into the Measure Menu. The display will show the file that is open and the 

flow of gas being pumped through the instrument. Below this will be whether the initialization is 

automatic or manual. If the initialization is automatic, the F-900 will precede directly to the 

measurement (Graph Mode) once the sensors have stabilized. If the initialization is manual, 

Monitor Mode will not be triggered until the user presses the right arrow to enter Monitor Mode.  

 Press the down arrow key to switch between automatic and manual initialization.  

 Press the right arrow to skip the Sensor Stability screen and proceed to the Graph Mode 

display.  

If the offset auto-correction feature is enabled, then the unit will run the set zero process 

automatically every 24 hours (or at the user defined time interval). The offset auto-correction 

utilizes Chamber Out, which should be left full of KMnO4 even if Chamber Out is set to “off” during 

normal measurements. For more details on the offset auto-correction, see page 35.  

 

Note: The F-900 ethylene analyzer sensors should be given 24 hours to stabilize after being on an 

airplane. Start a measurement and enable the Closed Loop (On). Then, allow the instrument to 

measure for 24 hours while connected to a power supply.  
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Graph Mode 
Graph Mode will be entered automatically once the unit has stabilized in Sensor Stability mode. 

This view graphically displays the measured C2H4 value over time. To switch Graph Mode into 

Monitor Mode, press the right arrow. To exit the measurement, press Stop. 

 

Figure 10: Graph Mode with red arrow indicating direction of movement. 

Directly below the graph is the current ethylene value. Above the graph is the dynamic range (on 

the left it is 1.000 ppm, on the right it is 2.000 ppm). The y-axis scale is set by the highest value 

shown in the buffer. This range will scale vertically, dependent on the highest concentration of 

ethylene measured. If the concentration is small, the dynamic range will reflect this. For example, 

the initial value was 0.162 ppm and there is a sudden peak to 7.578 ppm. As the spike or peak 

occurs, the graph will scale to 10.000 ppm. If the sample returns to 0.168 ppm, the scale will remain 

at 10.000 ppm until the graph and the buffer are cleared.   

The scale of the graph can be increased or decreased by using the up and down arrows. Pressing the 

up arrow will zoom in on the data, minimizing the visible range. Using the down key will increase 

the scale, up to 200 ppm. Note that the minimum range of data visible (down to 0.150 ppm) 

depends on the current data being graphed. For example, if the current data is 3.486 ppm, the user 

may use the up key to zoom in to the 5 ppm range, but cannot zoom in to a narrower 2 ppm range. 

The graph begins on the left side and moves with the vertical line towards the right as more data 

points are added. Once the time line reaches the right side of the display, the data will be 

compressed to the far left.  

The time scale relates directly to the vertical position line. In other words, the line moves to the 

right as new data points are added. Every time a data point is added, the time scale is incremented. 

For time under 10 minutes, the graph is updating almost every second. The bottom of the display 

shows the uptime of the F-900 and current battery level.  
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Monitor Mode 
The large bold value on the top line is the digitally filtered value of the raw ethylene 

measurements. Next, the relative humidity in percent, of the gas stream in the instrument is 

displayed followed by the temperature in degrees Celsius. The atmospheric pressure, is displayed. 

Press the down arrow to view the flow rate in milliliters per minute. The default flow rate is 80 mL 

per minute. If the unit has a high resolution CO2 sensor on board, the CO2 value in ppm will be 

displayed below the ethylene value. If the unit has a low resolution CO2 sensor, or O2 sensor on 

board, the value will be displayed in percentage (%).  

 

 

 

 

 

 

 

 If Autosave is enabled, “saved” will flash at the top of the display each time the data is 

automatically saved to the file.  

o Pressing ‘save’ during measurement when autosave is enabled will toggle the 

autosave feature off. 

 Press the Stop key to stop the measurement and exit to the Sensor Status display. 

 Press the left arrow to enter Graph Mode.  

 Press the right arrow to get to the Measurement Settings menu. 

 

The temperature and relative humidity sensors are located inside the instrument. Therefore, the 

temperature sensor is subject to heating by the F-900 internal electronics. The temperature 

reading is often 4-5OC above ambient and in turn, relative humidity readings are affected. 

The use of water in Chamber In (PolarCept, see page 8), will also affect relative humidity 

readings.  

The detection rate (Det. Rate) in nmol/second is calculated by the following formula, based on 

ethylene being an ideal gas.  

• Detection rate (n’) = (V*P)/(R*T).  

• Where volume (V)= flow rate * concentration (L/s)*(ppb) = nL/s  

• P = pressure (atm) = (kPa)*0.0098692 

• R= constant = 0.0821 

• T = absolute t (K) 

MONITOR       

3.26 ppm 
 

Humidity                           47.0% 
Temperature                     28.7C 
Pressure                     101.0 kPa 
Flow                                 200 mL 
Det Rate                 0.03 nmol/s 

 
Uptime 01:17   Bat 95% 
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The detection rate starts calculating the ethylene emission rate from the fruit. Emission rate is 

typically calculated with the following parameters and the weight of the fruit. 

• Flow rate: 0.2L/min = 12.0L/hr 

• Sensitivity to C2H4: 0.1 µL/L or 100 nL/L 

Therefore, the F-900 optimally detects around 1200 nL/hr. The unit is nanoliters of ethylene per 

gram fresh weight per hour.  

 

Measurement Settings 

The Settings screen is accessed by using the right arrow from Monitor Mode, and provides a short 

list of variables which may be manipulated while measurements are being made. The exterior 

Conditioning Chambers are turned On/Off, valves are closed causing gas to circulate internally 

(Closed Loop On/Off), or the ethylene zero calibration (Set Zero) can be initiated. Chamber Out is 

primarily used with potassium permanganate (KMnO4) for cleaning water and setting the 

instrument’s offset. Changes cannot be made to the settings menu if the F-900 is “correcting offset”. 

If the measurement is setup for PolarCept (Setup > Chamber > Chamber In = Special) then Chamber 

In cannot be turned on/off from the Measure > Settings menu.  The measurement must be stopped 

and default Setup Menu parameters changed.  

The Set Zero procedure begins by automatically closing the IN and OUT port valves on the front of 

the instrument (Closed Loop) and enabling Chamber Out (On) with KMnO4. The instrument will 

continue to record data to the file, with the mode listed as “offset”. The length of time for the offset 

can be changed by navigating to Setup > Calibration > C2H4 > Offset Correction. It is recommended 

to keep at 10 minutes. See page 34 for more details on ethylene offset performed from the settings 

screen. 

 

 

 

 

 

 

 

 

 

 

SETTINGS 

 

Chamber OUT                 On 
Chamber IN                    Off 
Closed Loop                    On 
Set zeros                    C2H4 
 

Uptime 01:15 Bat 75% 
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Figure 11: Measurement > Settings Menu display (left); flow path of internal gas stream 

(right). 

Notes About Measurements with the F-900 

Electrochemical Sensor Response 

The lag in sensor response is a natural phenomenon for charged porous membrane electrodes. The 

platinum electrode can be thought of as a series of cylindrical pores. Each of these pores will have a 

double layer in the radial direction. The interactions between the molecules, convection from air 

movement, electric fields and the concentration gradient result in a lag following a change in 

concentration1. Additionally, a lag is created due to the volume of internal tubing the instrument 

contains. Because of the volume of internal tubing, it takes about 120 seconds to see a response by 

the sensor.  

Auto-Escape Feature 

An upper limit auto-escape feature acts as a safety feature of the unit. This safety feature is always 

on. If the sensor detects over 200 ppm ethylene, the F-900 will auto-escape from Monitor Mode to 

prevent poisoning of the electrode. This will stop the measurement. If the sensor becomes 

poisoned, it will continually auto-escape with the error message "sensor out of bounds". If this 

happens, use potassium permanganate (KMnO4) in Chamber Out and set the instrument to Closed 

Loop. This will begin to clean the gas inside the instrument. If possible, the F-900 ethylene analyzer 

should be removed from the high concentration environment.  

Flow Block Error 

The display may show “flow blocked” and a very low flow rate (less than 40 ml/min) for several 

reasons. If this message appears on the display of the F-900, ensure that the intake on the front of 

the F-900 is free from obstruction and not covered. If connected to tubing or a fruit chamber, 

disconnect and reconnect the tubing from the IN port.  

If using water in Chamber In, remove the top panel of the F-900 and ensure no water has entered 

the F-900. There is a white hydrophobic filter directly down the flow path Chamber In to be 

checked for water, as well as a hydrophobic filter near the IN port on the front of the F-900. If water 

is found inside the tubing or filters, Stop the measurement and allow the instrument to dry out. Be 

careful no further water damage occurs when turning the pump back on. 

                                                             
 

 

 

11 Kontturi et al., “Ionic Transport Processes: In Electrochemistry and Membrane Science.” (Oxford University 
Pess) 2008 
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No SD card Present 

If the autosave is enabled and no SD card is present, the user will be notified by seeing “INSERT SD 

CARD OR HIT ENTER KEY”. After enter is pressed, “NO SD CARD” is visible on the Sensor Status 

display where the FILE and filename usually are. Pressing any other button besides Enter, will 

return to the main menu. Each time the F-900 tries to autosave, the unit will flash “write error” 

instead of “saved” at the top of the display.  

F-900RK: Using the Research Kit Fruit Chamber 
To use the F-900 Research Kit in the field or laboratory, attach a hose of the chamber wand to the 

IN port on the front panel. Slide the end of the wand into the chamber and tighten the thumb-screw. 

Make sure the connection is snug. The fans inside the chamber will begin to spin when the 

connection is established. The chamber either has a flat-bottom or a bottom-slit to allow for non-

destructive sampling. A fruit stem or petiole that is attached to the plant is passed through the slit 

and then closed in the chamber. This allows C2H4 levels to be recorded during ripening without 

damaging the fruit. Leaf chambers available for the CI-340 Photosynthesis System, from CID Bio-

Science, Inc. are compatible and interchangeable with the F-900 Research Kit.  

 

If the tube is not connected to the OUT port, ambient air will be used to replenish the fruit chamber.  

 

If the gas returning to the fruit chamber needs to be conditioned, consumables should be placed in 

Chamber Out and it should be turned on. Possible reasons to condition the air returning to the fruit 

chamber include scrubbing humidity (with silica gel) or scrubbing CO2 (with soda lime). Build-up of 

carbon dioxide may inhibit fruit respiration at high concentrations. At high concentrations, the 

sensor fails to consume all the ethylene, so KMnO4 could be used to scrub ethylene and not return it 

to the sample system.  

 

Figure 12: Using conditioned air to replenish the fruit chamber by connecting the IN and the 

OUT (left); using ambient air to replenish the fruit chamber by disconnecting the OUT 

(right). 
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To sample a fruit: 

 Open a data file to save the measurements to. 

 Attach the chamber to the F-900 by screwing on the wand to the top of the chamber. 

 Next, connect one of the tubes from the wand to the intake port on the front of the F-900. 

 Connect the black power chamber cable to the left of the display to power the fans in the 

fruit chamber. 

 Place the fruit inside the chamber and close it. 

 Observe and record the rate of change of ethylene over time with the F-900 Monitor Mode.  
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GC Emulation Mode  
To use the F-900 to analyze a small sample in a syringe, the GC Emulation Mode should be used. 
With the simple addition of our inline injection port, small volumes of analyte can be accurately 
measured.  

Calibration standard gas is not required for using GC Emulation Mode. Simultaneous results can be 
collected for all enabled sensors.  

There are several improvements compared to a Gas Chromatograph (GC): 

 No need for N2, H2, or bottled air 
 Portable 
 No heating or oven required 
 Predicts ethylene concentration without chromatography 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 13: GC Emulation port connected to front of instrument for small volume samples.  
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How GC Emulation Mode Works 

The GC Emulation Mode employs a patent pending Flow Inject Analysis to determine ethylene 
concentrations with typical sample volume of 10ml (larger sample volumes will provide greater 
accuracy). The resulting value is the comparison between before and after-injection measured 
values. As shown by Equation 1 below, the injection volume is determined by the expected 
concentration of ethylene and the detection limits of the sensor. If interfering gases are expected, 
their expected concentrations must be subtracted from the reported ethylene concentration.  

 

Equation 1:  0.025 𝑝𝑝𝑚𝑣 ≤
𝐼𝑛𝑗𝑒𝑐𝑡𝑖𝑜𝑛 𝑉𝑜𝑙𝑢𝑚𝑒∗𝐸𝑥𝑝𝑒𝑐𝑡𝑒𝑑 𝐸𝑡ℎ𝑦𝑙𝑒𝑛𝑒 𝐶𝑜𝑛𝑐𝑒𝑛𝑡𝑟𝑎𝑡𝑖𝑜𝑛

30𝑚𝐿
≤ 20 𝑝𝑝𝑚𝑣 

Exceeding the lower limit of Equation 1 will decrease the accuracy and precision of the result. 
Exceeding the upper limit will affect the sensitivity of the instrument and will cause the 
instrument to under-estimate measurements. 

Each injection should be done by the same technician, as human technique will alter the result.  

 
GC Emulation Mode Tips 

 In general, higher injection volume will also increase signal detection. Recommended 

minimum injection volume is 5 ml.  

 The F-900 requires about 5-10 minutes of warm-up time when using GC Emulation Mode. 

 
When using GC Emulation Mode, the protocol is to perform 1 injection per sample, which takes 

approximately 5 minutes: 

1. Stabilization time 

2. Sample injection (at least 10 mL) 

3. Processing time 

 

Note: Injection mode standard error (at two sigma) is ±10% of gas concentration. 
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GC Emulation Mode Operation Procedure 

1. Turn on GC Emulation Mode in the Setup>Measure menu. Press Save to save changes and 
exit to the main menu.  
 

 

 

 
2. Enter the main Measure menu, Setup injection port then press Enter 

 

 
    

Figure 14: Injection port setup. 
 

3. Wait for the instrument to stabilize.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Set parameter then press Enter.  

Stabilizing environment 

Enter: Skip 

C2H4   x.xxxppm 

Humidity 

Temperature 

Flow 

XX% 
Uptime 00:11 Bat 98% 

Mode                      GC Emulation  

Setup injection port 

then press enter 
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5. Inject the gas sample, then press Enter.  

 

 

                                           
Figure 15: Injection of gas sample. 

6. Wait while the sample is processing (~140 seconds). 

 

7. View the results, Enter to repeat for another sample or Stop to exit.  

 

 

 
 
 
 
 
 
 

Set parameter 

then press Enter 

Sample volume(ml)  

Results 
Enter: Repeat, Stop: Exit 

Injection Volume 
C2H4 
 
… 

Set parameter 

then press Enter 

Sample volume(ml)  
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Figure 16: Proper technique for filling glass syringe from sample bag for GC Emulation 
Mode. 
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F-900 Calibration 
The F-900 can be calibrated without any additional software. To access the calibration options, 

navigate to Setup > Calibration. The C2H4 ppb and ppm sensor, CO2 ppm and PCT sensor, and O2 

sensor are all accessible for on-device set zero and span calibrations. Refer to the specifications on 

pages 3-4 for the calibration schedule on each sensor. 

Note: “Set zero” and “offset” are interchangeable terms in the following procedures as well as 

“span” and “gain”.  

Pre-requisites 
The calibration process consists of three basic steps. The first step is obtaining an offset point (the 

zero point) and second step is obtaining a span point. Lastly, it is good practice to verify the 

calibration using another standard gas. See Table 1 for a summary for the standards recommended 

for each gas sensor. The blue columns are your offset points (step 1). The white columns are you 

span points (step 2). The green columns are your verification points (step 3). Note that CO2 ppm 

sensor has two options for obtaining the offset point. 

Table 1: Recommended Standards for Gas Sensors **can use ambient air to verify the O2 sensor 

 
20 
ppm 
(C2H4) 
  
gas  

10 ppm 
(C2H4)  
gas  

5 ppm 
(C2H4) 
 gas  

2 ppm 
(C2H4) 
 gas  

16% 
(CO2) 
gas  

5% 
(CO2) 
gas 

2,000 
ppm 
(CO2) 
gas 

1,000 
ppm 
(CO2) 
gas 

50% 
(O2) 
gas  

20.9% 
(O2) 
gas 

100% 
(N2) 
gas  

Potassium 
Permanga
nate 
(KMnO4) 

Soda Lime 
(NaOH-
KOH…) 

C2H4 
ppm 
sensor 

  

       
 

 

 

C2H4 
ppb 
sensor 

  

  

     
 

 

 

CO2 
PCT 
sensor 

    

  

   
 

 

 

CO2 
ppm 
sensor 

      

  

 
 

 

 

 

O2   
sensor 

        

   

 

  

All calibrations require the following: 

• Flow meter capable of measuring 200 mL/min and lower with accompanying T-junction  

(refer to Figure 18) OR an on-demand regulator (refer to Figure 17)  
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• Tubing with low outgassing properties (such as Viton) 

 

Below are some instructions on how to connect your standard gas to calibrate the gas sensors on 

your F-900. 

a. If using an On Demand Flow Regulator, directly connect the regulator to the IN port 
on the F-900. When using an On Demand-Flow Regulator, the gas is drawn out of the 
regulator/cylinder by the pump of the F-900. When the regulator is fully twisted 
onto the cylinder, the PSI on the gauge will move. Rotate the regulator until it is 
tightly onto the cylinder of gas (clockwise).  

i. The regulator can be removed from the cylinder (a small puff of gas will 
escape) to be used with other gas cylinders or for storage. To remove the 
regulator, twist counter-clockwise. 

 

 
Figure 17: Ethylene calibration gas cylinder with On Demand Flow Regulator 
connected to F-900 IN port. 

 
b.  If not using an On-Demand Flow Regulator, a T-valve must be used to release 

extra pressure to avoid damaging the F-900. Always open the regulator very 
slowly and allow only 1-2 PSI (6-13 kPa) until the ethylene value starts to increase 
on the F-900, reference Figure 18.  

c. A flow meter can be used in conjunction with the T-valve to be sure that the flow 
going into the F-900 is at appropriate levels and gas is not being wasted. Connect 
your standard gas to the input of the flow meter and adjust your regulator to the 
proper flow rate. Then connect from the output of the flow meter to the ‘in’ port of 
the unit.  
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Figure 18: T-valve in tubing. 

 
 

Standard Operating Procedure 
A similar menu flow is set up for each sensor on the F-900. Deviations from these standard 

operations will be further addressed under the specific sensor below. The F-900 will automatically 

close and open the needed valves for offset and span calibrations without manual change being 

required by the user.  

1. Under the Setup>Calibration menu choose the sensor you wish to calibrate by pressing the 

right arrow when desired sensor is highlighted. 

2. Options for calibration parameters and recalibration can be seen. Select Re-Calibration.  

Note: Changes to any of the calibration parameters should be performed under the 

supervision of a Felix Instruments technician only 

3. The display will prompt you to attach the appropriate standard gas for setting your internal 

offset. 

4. Connect your standard gas for the offset to the ‘in’ port on the front of the unit and press 

‘enter’. 

5. The instrument will automatically begin to set the offset and will give a countdown to 

completion. 

6. Once the offset is set the display will automatically change to ‘set parameter’. 

7. The ‘set parameter’ display will prompt you to enter the exact concentration of your 

standard gas. This can be found on the spec sheet delivered with your standard gas tank.  

a. Note: Be sure to note the units required. If the units required are ppm and your 

standard gas is 2000ppm, this would be entered as 02000.  

8. Connect your standard gas for span calibration. Hit ‘save’.  

9. The instrument will automatically begin to calculate the span calibration and give a 

countdown to completion.  

10. The final screen will display the calibration results.  
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Ethylene Sensors 

Ethylene PPB Sensor 

Setting the offset for the ethylene ppb sensor deviates from the SOP given above and the procedure 

is described below.  

1. Select the re-calibration function for the ppb C2H4 sensor. 

2. The display will ask you if you want to use the KMnO4 chamber as zero source, press ‘enter’ 

for yes. 

Note: It is advisable to use this option. If zeroing the PPB C2H4 sensor with a 

standard gas rather than using the KMnO4, an additional step of setting up zero gas 

is required (with the exact amount of C2H4 in gas source). Contact Felix Instrument 

Support if you need further instructions for this routine. 

3. After pressing ‘enter’ the display will immediately prompt you to ‘connect calibration gas’, 

this is referring to your standard gas for setting span. 

4. The next screen will ask you to ‘set parameter’ where you enter the exact concentration of 

your standard gas. Press ‘save’.  

Note: The entered concentration should be in ppb. If your standard gas spec sheet 

reports the value in ppm, convert to ppb.  

5. The F-900 will automatically start setting offset using the KMnO4 in Chamber out and will 

give a countdown to completion. Zero calibration takes the instrument around 15-20 

minutes to complete.  

6. Once offset has been set, the F-900 will immediately start setting span with your calibration 

gas.  

7. The final display will show ‘calibration results’ and prompt the user to accept by pressing 

‘enter’ or pressing ‘stop’ to cancel the calibration.  

Ethylene PPM Sensor 

Calibration of the ethylene ppm sensor follows the standard operating procedure. Please see page 

29.  

CO2 Sensors 
The CO2 sensor needs to be enabled in the Setup>Sensor>Sensor Selection menu to access the 

Setup>Calibration>CO2 menu.  

 

 

 

 

 

 

CO2 CALIBRATION 

 

CO2 PPM 

CO2 PCT 
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As given in the specifications on page 3, CO2 ppm zero calibration is recommended weekly. CO2 PCT 

zero calibration is recommended every six months. However, if the unit is in an environment where 

the temperature fluctuates frequently, zero calibration may be necessary more often than the 

recommended intervals.  

CO2 PPM 

Calibration of the CO2 ppm sensor follows the standard operating procedure when using a standard 

gas to set zero. Please see page 29. An alternate method exits for setting zero with the use of Soda 

Lime and is described below.  

 Note: This is only an option if the research kit has been purchased with the unit. 

1. Select the re-calibration function for the CO2 ppm sensor.  

2. The display will read ‘internal offset’ and prompt the user to setup N2. At this point the 

user can alternatively connect Soda Lime.  

3. The Soda Lime needs to be connected to the inlet and outlet port to create a closed loop 

system.  

 
Figure 19: Soda lime closed loop system. 

 

CO2 Span Buffer Tank System Instructions 

If access to standardized CO2 gas is limited, ambient air can be used to calibrate the CO2 span. 

Ambient air should only be used if a buffer tank system is implemented. The buffer tank system will 

help stabilize fluctuations in CO2 levels, providing an ambient air with approximately 400 ppm CO2 

(depending on proximity to urbanized areas).  

Tips for Calibrating the F-900 CO2 Sensor with a buffer system: 

 The operator should stand away from the F-900. 

 Use extra tubing to get the intake source away from human breath. 
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 Use a buffer tank system to stabilize the intake source. 

 

1. Find and clean an empty bottle with cap, 

which is at least 3L in volume. 

2. Drill two small holes in the cap of the buffer 

bottle: 1 hole is for the intake tube and 1 hole 

is for the out tubing. 

 

 

 

 

3. Insert a short plastic tube into the cap of the 

buffer bottle for the “out”.  

 

 

 

 

 

4. Insert a longer plastic tube into the cap of the 

buffer bottle that will connect to the “IN” of 

the instrument. Use hot glue or otherwise 

seal the tubing to the cap, with no leaks. 
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5. Make sure that the tube and cap has no leaks. 

 

 

 

 

 

 

6. Connect the “in” tubing to the intake port on 

the instrument. 

 

 

 

 

 

 

7. To use the buffer bottle, make sure that the 

tubing is clear from obstruction. Connect the 

In tubing to the unit. Place the buffer bottle 

in a location that has stable CO2 

concentration (away from operator, cars, 

furnace, photosynthesizing plants). Here, 

ambient air CO2 levels should be 

approximately 400 ppm. 

 

 

Note: The instrument shown in these images is a CI-340 Photosynthesis Analyzer (CID Bio-Science, 

Inc). The buffer tank system technique can be used to help stabilize the ambient intake of any IRGA 

CO2 sensor (images courtesy of ZealQuest, China). CO2 PPM 

CO2 PCT 

Please follow the Standard Operating Procedure on page 29 and refer to Table 1 on page 27 to 

calibrate this sensor.  
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The firmware supports a 3 point calibration for this particular sensor for added accuracy between 

the 0-20% range. The sensor leaves our facility with the following 3 point span calibration:  

• 0.1% CO2 

• 5% CO2 

• 16% 

If you run a span calibration for this sensor, it will replace the closest point from the 3 points listed 

above.  

O2  
Please follow the Standard Operating Procedure on page 29 and refer to Table 1 on page 27 to 

calibrate this sensor.  

Ethylene Sensor Zero Calibration  
The instructions above are for two point calibrations of the F-900. Solely setting zero for the 

ethylene sensor can be accomplished through the Settings screen. The Settings screen is accessed 

by using the right arrow from Monitor Mode, and provides a short list of variables which may be 

manipulated while measurements are being made. The Set Zero procedure can be done manually or 

the F-900 can be programmed to perform the process automatically, as described below. In both 

cases, potassium permanganate (KMnO4) is used to scrub ethylene from the gas and set the zero. 

Using PolarCept (water in Chamber In) is not necessary during the zero calibration.  

It is not recommended to use N2 gas to zero the C2H4 sensors. N2 gas typically has hydrocarbon 

impurities which could create signal for the ethylene sensor. Standard ethylene gas (0 ppm) can be 

used to perform the zero calibration. *(To set zero for the PPM sensor only, navigate to Setup > 

Sensor > Sensor Selection > C2H4 PPB > OFF before proceeding with the following steps). 

Manually Set Zero 
This procedure falls under the Measurement>Settings menu option: 

1. Place potassium permanganate (KMnO4) in Chamber Out. 

2. Power on the instrument and allow adequate warm-up time (3 min). 

3. Press the right arrow when Measure is highlighted to begin a measurement. 

4. Let the sensor stabilize and automatically begin measuring. 

5. Once the measurement begins, press the right arrow until you access the “Settings” menu.   

6. Scroll down to “Set Zero”. 

7. Press the right arrow to highlight “C2H4”. 

8. Press Enter.  

9. A message appears asking “zero selected sensors?” 

a. Press Enter to confirm.  
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10. A message appears asking to “Place KMnO4 in CH_Out.’” 

a. If KMnO4 is in Chamber Out, press Enter to confirm. 

11. The display will switch to Monitor Mode and “correcting offset” is shown at the bottom. 

a. The settings will automatically change to: 

i.  Chamber Out = On  
ii. Chamber In = Off 

iii. Closed Loop = On  
12. The instrument will run for the amount of time set in the following menu: Setup > 

Calibration > C2H4 > Offset Correction. It is recommended to keep this setting at 10 
minutes.  

13. The instrument will make a “beep” sound twice to indicate that the offset correction is 
complete.   

a. The instrument will return to Monitor/Graph Mode and “correcting offset” will no 

longer appear on the display when the zero calibration is complete.   

14. The measurement will continue with the original settings for the conditioning chambers 
and Closed Loop on/off. 

 

 

 

 

 

 

 

 

 

 

 
 
 

Figure 20: Measurement > Settings Menu display (left); flow path of internal gas stream 

(right). 

 

Automatically Set Zero: Offset Correction 
Please see Setup>Calibration>C2H4>Offset Correction on page 442 for additional information or to 

enable/disable the automatic set zero feature. The automatic offset will stop a measurement to set 

SETTINGS 

 

Chamber OUT                 On 
Chamber IN                    Off 
Closed Loop                    On 
Set zeros                    C2H4 
 

Uptime 01:15 Bat 75% 
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the zero, and then re-start the measurement automatically. This should be used during 

continuous monitoring or experiments longer than 24 hours.  

The offset correction duration is adjustable (default: 30 minutes) and happens during “Sensor 

Stability”, the first screen when measurement mode is initiated. The default interval between offset 

corrections is 24 hours for continuous use, or during the next start-up for units that are not running 

continuously. If the unit is exposed to concentrations greater than 200 ppm during the 

measurement period, the offset correction will be initiated the next time the user enters “Sensor 

Stability”, even if less than 24 hours have passed.   
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F-900 Menu System Diagram  
Below is a map of the F-900 ethylene analyzer menu system. Press the right arrow to enter a menu 
and the left arrow or Stop to exit.  
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Setup Menu 
The F-900 has a number of utility functions that allow the user to manage the instrument’s 

capabilities. These functions are accessed by pressing the right arrow when Setup is highlighted on 

the Main Menu. The setup utility options are: Measure, Autosave, Sensor, Calibration, Time, Flow, 

Chamber, Terminals, and Board. Use the up or down arrow to select the desired option and then 

press the right arrow to enter the choice. Press the left arrow to exit to the Main Menu. 

 

 

 

 

 

 

 

 

Setup Measure 
The Setup>Measure menu allows the user to setup a measurement in 1 of 2 different modes: 

Monitor Mode or GC Emulation Mode. Instructions to use Monitor Mode are started on page 15. GC 

Emulation Mode is available with the F-900 Research Kit and requires the use of the inline injection 

port with septum. To save changes in the Setup>Measure menu, press Save. Use the up and down 

arrows to toggle between options. 

 

Setup Autosave  
To select the Autosave feature, press the right arrow key when Autosave is highlighted. This allows 
the user to setup the instrument to automatically store measurements, and to start a new 
measurement without explicitly saving the old one. This mode is convenient when taking fast, 
repetitive measurements, as well as when it is not necessary to review each measurement 
immediately after taking it. The files created by the F-900 are saved in .csv (comma separated 
value) format, to be opened with Microsoft Excel or other spreadsheet program. 
 

In the Setup>Autosave menu, the top line of the display will read “enter” 

and “save” and the directional arrows. Next to Autosave and “Yes” or 

“No” indicating whether this feature is turned on or off. Below Autosave 

is the “Interval” option where the user can set the time interval. This is 

the length of time in seconds between saves, when the autosave feature 

is selected. The default autosave interval is 10 seconds. 

Setup               Menu 

 

Measure 

Autosave 

Sensor 

Calibration 

Time 

Flow 

Chamber 

Terminals 

Board 

Autosave             Menu 


Autosave                  Yes 
Interval                    010 
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 To set the instrument up to automatically store measurements press the right arrow key to 
highlight the word “no” on the display, then press the up/down arrow to switch to “yes”. 
Press the Save key to save the configuration. After saving, it will exit to the Setup Menu.  

 To set the instrument up to not automatically save measurements, toggle the up/down 

arrow key until “no” is on the display, then press the Save key to save the configuration. To 

save data when Autosave is disabled, press the “Save” button during the measurement.  

 When Autosave is highlighted, press the up/down arrow to get to the Interval line and then 

use the right arrow key to highlight the time interval value. Press the up/down arrow key to 

change the time interval. Press Save to save changes. 

 If Autosave is enabled, pressing ‘save’ during measurement will toggle Autosave to off. 

 To avoid changing any configuration, press the Stop key to exit back to the Setup Menu. 
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Setup Sensor 
The Setup>Sensor Menu has Sensor Selection. Sensor Selection allows the user to turn on/off the 

different sensors of the F-900. After selecting any of the menu options from the Setup>Sensor 

menu, the display will prompt “Are you sure you want to continue?” Press Enter to continue to the 

selection.  

Not all F-900’s are built with all sensors, so see the Production Check Sheet at the end of the manual 

to see which sensors are included in your unit. All units are equipped with a High Resolution C2H4, 

ethylene sensor (PPB) and an extended range C2H4, ethylene sensor (PPM). The C2H4 PPB measures 

from 0-4 ppm. The C2H4 PPM measures from 4-200 ppm, with a lower detection limit of 0.5 ppm. 

Optional sensors available for carbon dioxide are the PPM or the PCT, which gives values in percent 

(%). There is also an additional sensor available for O2 (percent oxygen). The optional sensors are 

in series, meaning the gas sample will flow to the CO2 PPM, then CO2 PCT sensor, then O2 sensor. 

The C2H4 sensors are parallel, meaning a valve changes the gas flow between the C2H4 sensors, 

again depending on the current concentration.  

Sensor Selection: Press the right arrow when Sensor Selection is highlighted to see the list of 

sensors.  

 

 

 

 

 

 Use the up/down arrows to select the sensor to adjust and then the left/right arrow keys to 

switch between columns. Once in the column with the On/Off, use the up/down arrow to 

turn the sensor On/Off.  

 Both ethylene sensors should always be turned “On” for measurements. The 

firmware will control which ethylene sensor is used to measure the gas sample.  

 If sensors are not included in your instrument, please set them to “Off”.  

 If not actively using the CO2 PPM sensor, set it to “Off” to conserve battery life.  

 Press Save to save any changes.  

 Press Stop to exit to the Setup Menu.  

 

 

Setup        Sensor 

 

C2H4  PPB         On 

C2H4  PPM        On 

CO2    PPM        Off 

CO2    PCT    Off 

O2                     Off 
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Setup Calibration 
Please see the F-900 main calibration section, starting on page 27, for calibration procedures. 

Calibration Parameters and re-calibration steps for C2H4, CO2, and O2 sensors can be accessed via 

the Calibration Menu. Press Enter to confirm and get into the menu. The options at the 

Setup>Calibration menu are C2H4, CO2, O2, system DAC flow and injection parameters.  

C2H4 Calibration  

**Re-calibration or changes to any of the Calibration Parameters for C2H4 should be 

performed under the supervision of a Felix Instruments technician only.** 

The options from the C2H4 Calibration menu are for the C2H4 PPM sensor, C2H4 PPB, offset 

autocorrection or sensitivity correction. Calibration Parameters are set by a Felix Instruments 

technician during factory calibration and are specific to each instrument. The internal offset is the 

ADC voltage output from the sensor when no ethylene is present, and gain describes the linear 

increase in the ADC voltage output from the sensor in the presence of ethylene. The RH, T slope and 

offset are applied to the ADC voltage to correct for shifts in relative humidity and temperature that 

may occur during the sample period. the temperature and RH parameters are automatically 

populated during ppb sensor span. 

 

 

 

 

 

 

Offset Correction 

Offset Correction allows the unit to adjust the baseline, or zero, for the ethylene sensors, which may 

drift from the zero set at the time of calibration. The default interval between offset corrections is 

24 hours for continuous use, or during the next start-up for units that are not running continuously. 

If the unit is exposed to concentrations greater than 200 ppm during the measurement period, the 

offset correction will be initiated the next time the user enters “Sensor Stability”, even if less than 

24 hours have passed. The offset correction relies on there being KMnO4 in Chamber Out.  

 

Calibration               Parameters 
 
Internal offset 
Internal gain 
Calibrated RH 
Calibrated t 
RH slope 
RH offset 
t slope 
t offset 
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Automatic: If “Yes” is selected, the unit will automatically adjust the offset every 24 hours or upon 

startup if more than 24 hours have passed between uses. The offset will be corrected when the user 

first enters measurement mode and is in the “Sensor Stability” screen. To enable the automatic 

offset adjustment, and to ensure that the latest offset adjustment so that the unit is using the most 

recent zero, change the “Automatic” line to “Yes”.  

Interval: The offset correction interval can be changed from 24 hours (default) to any user selected 

interval in hours.  

Duration: The amount of time the offset correction lasts. It is recommended to have it between 15-

30 minutes.  

  

         Offset correction 

 

Automatic  Yes 

Interval (hour)  024 

Duration (min)  30 
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Flow Rate Calibration 

To calibrate the flow rate on the F-900, a separate flow meter is required. Please contact Felix 

Instruments Support for detail instructions. 

 

Setup Time and Date 
To change the time and date on the F-900, press the right arrow when “Time” is highlighted on the 

Setup Menu. This utility allows the user to set-up the instrument in different time zones or to adjust 

the time after daylight savings.  

 To change the time on the instrument, use the up/down arrows to change the values. Use 

the left/right arrow to highlight the appropriate column. Then, make the appropriate shift 

in time and press Save.  

 
 
 
 
 
 

Setup Flow 
The air flow of the F-900 is an important factor for taking good measurements. The default flow 

rate is 80 ml/min. Flow rate is adjustable from 80-200 ml/min.  

A flow value below 80 ml/min can negatively impact sensor functionality. If measuring bottled gas, 

a lower flow rate may be used in order to reduce gas waste. If measuring open air, a higher flow 

rate (~200 ml/min) is acceptable. The default flow rate is 80 ml/min.  

 

 

 

 

 

 

 

 

To make adjustments: 

1. Go to Setup>Flow and press the right arrow. 

2. Use the up/down arrows to adjust the value. 

3. The Set Flow value is found in ml/min to the far right.  

4. The Actual Flow value will change to match the set flow. 

5. Press Save to save changes and exit back to the Setup Menu. 

6. Press Stop to exit back to the Setup Menu without saving.  

Setup                              Time

 

03  28  2013     16 : 33 : 24 

Setup                                              Flow

 

Set Flow                                        80 

Actual Flow              80
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Setup Chamber 
The Setup>Chamber menu allows you to turn on/off the in-line conditioning columns on the back of 

the instrument. The settings in Setup>Chamber are the default settings to be used to start a 

measurement. Once a measurement is in process, conditioning chambers can be turned on/off in 

the Measurement>Settings menu. If the measurement is started with PolarCept enabled, the 

measurement must be stopped to make changes to Chamber In at the Setup > Chamber menu.  

The removable plastic containers are used to hold the consumables potassium permanganate, 

distilled water, soda lime, and silica gel. Keep the plastic containers on the F-900, even when 

empty, to protect the brass intakes. Always ensure the conditioning chamber is seated 

properly when screwing it on the F-900. 

The purpose of the inbound chamber, Chamber In is to condition the air before it reaches the 

sensor. Chamber In additionally provides a “special mode” where distilled water is used to filter out 

alcohols before the electrochemical sensor. The use of distilled water in the Chamber In is referred 

to as PolarCept. It is recommended to use PolarCept (Chamber In: Special) for most ethylene 

measurements. PolarCept is intended for distilled or deionized water only.  

 

 

 

 

 

 

 

 

 

Figure 21: Solids Chamber and Water Chamber on back of instrument.  

Chamber Out is on the left of the back panel. Chamber Out is the last chamber before the gas OUT 

port. If the outlet gas stream is connected to the field kit chamber or to the inlet of the unit, it can be 

used to condition the incoming gas after it leaves the sensor. Chamber Out is used with 

potassium permanganate (KMnO4) for zero calibration of ethylene sensors. Chamber Out 

must be filled with KMnO4 while Chamber In is set to special mode.  

Alternatively, Chamber Out could be used with soda lime to remove CO2 from the gas stream. 

Similarly, silica gel is used to scrub water from air and create a 0% relative humidity gas. Most 

commonly, potassium permanganate is used to for zero calibration of the ethylene sensor. KMnO4 

beads (not dust) should be sourced locally by the user.  
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KMnO4 has an added color indicator that turns from purple to brown when it expires and 

needs replacement. The silica gel from blue to pink when replacement is necessary.  

To use Chamber Out to condition the air replenishing the fruit chamber, enable Chamber Out in the 

Setup>Chamber menu and fill Chamber Out with the appropriate consumable. Connect the fruit 

chamber hoses to both the IN and OUT ports on the front of the F-900.  

 

 

 

 

Figure 22: The back of the F-900 with removable and refillable containers for distilled water 

and KMnO4 (left) and a diagram showing the flow path of the gas stream (right). 

Chamber In is on the right side of the back panel. This chamber can be enabled in two different 

modes. For PolarCept, Chamber In should be filled with distilled water to help filter out interfering 

gases in the air stream. By passing the gas sample through the water, polar molecules are trapped 

or filtered from the airstream. Using Chamber In with distilled water as a filter can help reduce the 

interference measured when alcohol or other light polar molecules (known interfering gases for the 

F-900 electrochemical sensor) are present. Also, using the water trap can help keep the 

electrochemical cell hydrated, with longer periods of time between needing to refill the 

electrochemical sensor.  
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There are 3 options for Chamber In in the Setup>Chamber menu.  

1. Chamber In set to Off. 

2. Chamber In set to On. 

a. To use soda lime or silica gel to condition the gas stream before it is 

measured, turn Chamber In to On and place the consumable in the 

conditioning chamber.  

3. Chamber In set to Special.  

Use the up/down arrows to select Chamber Out or Chamber In. Use the right arrow to get to Off/On. 

Next, use the up/down arrow to switch between On or Off, or set the Measure or Cleaning period in 

minutes. When Chamber In is set to Special, you will see Measure and Cleaning Period appear 

below.  

 

 
 
 
 
 
 
 

 Fill Chamber In with distilled water to max fill line (located on back of F-900)  

 This mode may not be applicable at high ethylene concentrations. 

 When the F-900 is using the water to filter out alcohol, the water must be cleaned by 

running a longer cleaning period than the measure period.  

 

To use the PolarCept water trap, set Chamber In to Special. Fill Chamber In with approximately 

35mL of DI water. Do not fill beyond the max fill line on the back of the instrument. Next, set the 

length of the measuring period in minutes. This is the time the F-900 will take to do a measurement. 

When using the water trap, a stabilizing time of at least 3 minutes is required before being able to 

record a measurement. However, a longer period of measurement (6-7 minutes) is required for 

accurate readings beyond the stabilization period. Actual times will depend on individual 

application/environment.  

The length of time required for cleaning will be dependent on the make-up of the gas(es) being 

sampled. The more interfering gases that are present, the longer the water will need to be cleaned. 

The main reason for the cleaning step is to keep the water in the maximum adsorption range. As the 

water becomes polluted with alcohols, it will not filter as effectively. This results in an increase in 

signal from interfering gasses escaping the filter. A small measurement to cleaning time ratio is 

suggested because the longer the measure time with the filter, the longer it will take to clean. A 

recommendation of 6 minutes of measure and 12 minutes of cleaning is better than 20 minutes 

Chamber                    Menu 

 

CHAMBER_A OUT             Off 

CHAMBER_B     IN           SPECIAL 

MEASURE PERIOD              6 MIN 

CLEANING PERIOD          17 MIN 
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of measure and 60 minutes of cleaning. For long-term monitoring, cleaning time may need to be 

extended upwards of 50-60 minutes. At the end of the cleaning time, the C2H4 reading should be low 

(less than 0.5 ppm). If not, lengthen the cleaning time and repeat the test. During the cleaning 

period Chamber Out filled with KMnO4 is utilized to clean the DI water of the interfering gases. 

Therefore, Chamber Out must be filled with KMnO4 when Chamber In is set to special mode.  

When the F-900 has PolarCept turned on, the Monitor Mode display top line will indicate B_SPEC, 

meaning that Chamber In is enabled in Special mode. Next, the current state (measure or cleaning) 

will be shown. If the F-900 is in a state of Measure, the data will reflect the current measurement. If 

the F-900 is in a state of Cleaning, “Clean” is shown in the upper right corner of the display.  

 
 
 
 
 
 
 
 
The F-900 has two hydrophobic filters in-line with the internal tubing. This is to protect the F-900 
in case any water is sucked into the instrument when using PolarCept. To avoid drawing water 
into the internal tubing of the F-900 when using PolarCept: 

1. Fill conditioning Chamber In only to the fill line and never completely fill the conditioning 
chamber with water. 

2. Always keep the top panel of the F-900 facing up and do not tilt the instrument when 
there is water in the conditioning chamber. When water in Chamber In, do not operate the 
instrument with the display panel facing upwards.  

3. Do not transport or tip the F-900 if water or moisture is in Chamber In. Before 

transport or moving the F-900, Chamber In should be completely dry to prevent even small 

drops of liquid from entering the unit. 

4. If the Relative Humidity sensor reads high or a “flow blocked” error appears on the display, 
open the top panel of the unit and inspect hoses for liquid. If liquid has accumulated at the 
hydrophobic (blue) filter, it should be disconnected and drained. If liquid has penetrated the 
hydrophobic filter the unit will need to be serviced to prevent circuit board failure.  

 

  

B_SPEC                       MEASURE 

0.160 ppm 
HUMIDITY                        47.0% 

TEMPERATURE               28.7C 

PRESSURE                 100.4KPa 
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Setup Terminals 
The Setup>Terminals Menu is where the F-900 can be setup to have an external fan or gas control 

connected to the terminal block. The terminal block is located between the chambers for 

consumables on the back panel of the F-900. The F-900 can turn on and off the gas based on the 

measured ethylene concentration of the room (or chamber). Other control applications using the 

terminal block are possible, such as controlling ethylene scrubbers or connection to an external 

control system.  

The F-900 will perform action at the high and low levels, when set. If the concentration of ethylene 

rises above the Gas_Hi, the gas will be shut off. If the ethylene concentration is lower than the 

Gas_Lo, the gas will be turned on.  

 
 
 
 
 
 
 
 
 
 

 Press the up/down arrow to switch between parameters.  

 Press the right arrow to switch to the column containing the values in ppb (parts per 
billion).  

 Use the up/down arrow keys to set the desired level.  

 Press the left arrow or Save to exit back to the Setup Menu. Any changes made will 
automatically be saved. 

 Enabling CONTL_OUT will turn on the standard terminal control, using the output of the 
pins to control turning on or off the gas and/or the exhaust fan.  

 Enabling CONTL_IN (Clean) allows use of the analog input pin to supply a voltage to control 
the cleaning mode (input signal). This terminal control mode was developed for using the F-
900 with other external advanced control systems. When this mode is not being used, set to 
DISABLE.  

o Note: if Setup>Chamber: Chamber In is currently set to Special, enabling CNTL_IN 
(CLEAN) will overwrite Chamber In to Off. 

o Terminal Connections:  

▪ Pin 1: Ground 

▪ Pin 10: Control voltage. Control voltage could be applied during 
Measure>Monitor Mode to control cleaning mode. Specifically: 

• 0.0-1.0V: Cleaning disable (Closed Loop Off, Chamber In Off) 

• 1.5-5.0V: Cleaning enable (Closed Loop On, Chamber In On) 

Setup                       Terminals 
VALUE                            PPB 
 
GAS_HI                         00000 

GAS_LO                        00000 

CONTL_OUT              DISABLE 

CONTL_IN (Clean)   DISABLE 
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To connect a gas control to the terminal block of the F-900, first pull off the removable portion of 

the terminal block (pull straight out). The piece in the figure below will separate from the F-900. 

Slide the wire from what is going to be controlled through the opening for the appropriate pin. Use 

a screw driver to tighten and clamp onto the wire, creating a connection. The removable section of 

the terminal block is designed to stay with the fan, gas or external control so, if the F-900 needs to 

be moved, the terminal block can be disconnected easily. The total power draw of the F-900 is .5-1.5 

AMP, the max of 1.5 is assuming all sensors are installed and running. 

 
 Figure 23: The removable piece of the F-900 terminal block. 
 
 
Table 3: Designations of the 10 pins of the terminal block (On = 5V; Off = OV): 

PIN  Function 

1  Ground 

2 Current Loop (reserved) 

3 Plus 5 volts (limited through 4.7 ohm resistor) 

4 Gas valve control (C2H4): when CONTL_OUT is ENABLE, OFF if C2H4 > GAS_HI, ON if 
C2H4 < GAS_LO 

5 Ready signal (5V): ON if during measurement (except correcting offset), OFF otherwise 

6 Alarm or error indicator: ON if one of the following happen: battery low/flow 
blocked/signal out of range/sensor error, OFF otherwise 

7  CO2 analog output: 4-20mA for 0 - max CO2 range (2000ppm or 100%) 
8 C2H4 analog output: 4-20mA for 0 - max C2H4 range (20ppm or 200ppm) 

9 Analog Input (reserved) 

10 Analog control input for cleaning: use with CONTL_IN enabled 

 

The digital outputs (4, 5, and 6) can sink up to 45mA to drive an optocoupler. They can only source 

0.1mA. Connect the optocoupler photoemitter anode to pin 3 (+5V) and the cathode to the digital 

output.
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Setup Board 

The Setup Board Menu should only be changed by a Felix Instruments technician. This menu allows 
the user the select the type of hardware platform that the unit operates on, and should only be 
changed at installation, or if hardware is upgraded.  
 
The time interval between cpu/microprocessor calculations reaching the digital to analog converter 
(DAC) output to pins 7 and 8 on the terminal block is every 200 milliseconds. The internal sensor 
communicates analog signal to the analog to digital converter (ADC), which then supplies digital 
output to the microprocessor. The microprocessor then provides digital values for calculated 
concentrations displayed on the F-900. Those concentrations are then updated (every 200 
milliseconds) to a DAC output on the terminal block (for CO2 and Ethylene).  
There is no output for the O2, but there is for the CO2 and C2H4 sensors. 
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View Menu 
The View Menu can be accessed from the main menu screen by pressing the right arrow key when 

“View” is highlighted on the display. This menu allows the user to navigate to and see the files, as 

well as check on many features of the F-900. Options from the View Menu are: Files, Voltage, 

Battery, Flash, Time, GPS, and SD card.  

 

View Files 
The View>Files Menu allows the user to review the filenames and file size of any files on the F-900. 

To view collected and saved data, either download files via USB or eject the SD card and insert it in 

a computer. In the View>Files mode, the top line of the display will show the word “View” on the 

left and “Files” on the right. Below this, the column on the left contains the filename and the column 

on the right contains the file size.  

The options are: 

 use the up or down arrow keys to scroll through the files  

 press the left arrow or Stop to exit to the View Menu 
 
 
 
 
 
 
 
 
Note: A file with a negative number for the file size is corrupt. This file should be deleted and re-
created. 
 
 

View Voltage 
The View>Voltage Menu shows the current voltage of the instrument. Press the right arrow when 

Voltage is highlighted to check the unit’s voltage. Press the left arrow or Stop to exit back to the 

View Menu.  

 

View                                    Files 

File01                                 3201 

RoomA2                            1022 

Fruit7                                        0 

View                          Voltages 

V_System     =     5.98v 

V_Charger    =    4.64v 

V_3volt         =    3.31v 

V_Analog      =    2.07v 
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Voltage is set for each individual unit before leaving the Felix Instruments factory and is board 

specific. For default voltage values, please see the Production Test Check Sheet at the end of the 

Instruction Manual for factory voltage settings. V_System is the voltage of the control board. The 

voltage for V_Charger should increase when you connect the USB charger. V_3volt is the digital 

voltage from the CPU and the V_Analog is the converted analog voltage.  

 

View Battery 
The View>Battery Menu displays indicates on the top line if the unit’s Charging is On or Off, or if the 

unit is connected via USB cable to a computer. The QBAT value shows the battery level in 

hexadecimal follow immediately by the battery level in percent. VBAT shows the voltage of the 

battery and TBAT indicates if the temperature of the battery is ok. The Charge shows the output 

status of the battery charger. Press the left arrow or Stop to exit to the View Menu.  

 
 
 
 
 
 
 
 
 

When the instrument is connected to the charger, the top line will indicated Charge On. Charge Off 

indicates that the unit is not charging. USB Host in the upper left corner indicates that the unit is 

connected to the computer or that the power supplied by the charger is not full charging voltage 

(unplug any other devices using the same charger).  

The QBAT hexadecimal number should be changing and the battery percent increasing. Also, the 
voltage will begin to increase slowly. The Charge will read “off” when no charger is plugged in and 
“Complete” when finished charging. The Board refers to the hardware version of the unit. Features 
described in this manual are associated with all versions of hardware. When discrepancies occur, 
they are listed, along with the version that they are associated with.  

Other View Menu Options 
The View>Flash option is only accessible by Felix Instruments technicians.  

The View>Time screen displays the current time on the instrument. Press the left arrow or Stop to 
exit back to the View Menu. The View>SD card screen indicates if an SD card is present in the unit, 
as well as other information about the SD card. If no SD card is in the instrument, or if the SD card is 
not fully inserted, “no SD card” will appear on the display. 
 

GPS System Features 

The F-900 has a built-in GPS system which can relay the longitude, latitude and altitude of the 

instrument when performing measurements. The View>GPS screen displays the mode of the GPS 

Charge                Off 

 

QBAT:    a413   60% 

VBAT:    3.840V 

TBAT:   OK 

Charge:         Off 

Board:  v6 



F-900 Instruction Manual 5/8/2017 

1554 NE 3rd Ave, Camas, WA 98607, USA                   Phone: (360) 833-8835 54 
sales@felixinstruments.com                                         www.felixinstruments.com 

sensor (SEN= $GPGGA), as well as the values for latitude, longitude, altitude and indicates the 

number of satellites currently connected to. Press the up/down arrow to display the latitude, 

longitude and altitude information only.  

 

 

 

 

 

The GPS uses GMT or Greenwich Mean Time for a standardized time. The GMT is displayed as the 

time (TIM) on the GPS menu and is synchronized with minute and second alignment. Often, when 

the instrument is turned on indoors, the latitude, longitude and altitude will be blank. This occurs 

when no satellite signal can be obtained by the instrument. Powering up the F-900 outdoors will 

correct this problem and allow latitude, longitude and altitude readings to be taken. 

<stop>       <save>                      

SEN =                                          $GPGGA 
SAT =                                                      05 
TIM =                                  015546.806 
LAT =                                   45.58792          
LON =                                  -122.37459 
ALT =                                            10.6 



F-900 Instruction Manual 5/8/2017 

1554 NE 3rd Ave, Camas, WA 98607, USA                   Phone: (360) 833-8835 55 
sales@felixinstruments.com                                         www.felixinstruments.com 

 File Menu 
The File Menu is accessed by highlighting “File” on the Main Menu and pressing the right arrow key. 

Here, the user can manipulate files on the F-900, with options to clear, delete, create and open files.  

The F-900 uses an SD card to store all measurements. This means the user is able to create, clear 

and delete any measurement file.  

To view data on a computer, simply insert the SD card into the computer’s SD card reader. The 

computer should automatically detect the SD card as a new storage device and mount the drive so 

that measurement data will be accessible by any computer application. The mini-USB port can also 

be used to establish a USB connection with a computer to transfer data from the F-900.  

 

Clear a File 
Pressing the right arrow key when “Clear” is highlighted on the display enters the menu to clear 

files. This mode allows the erasure of the file contents without changing the file name or set-up. 

This feature is useful if it is necessary to do a number of similar measurements. The user can take 

these measurements to a particular file, copy the results, clear the file, and be ready to take a new 

set of measurements to that file. 

 

 

 

 

The top line of the display reads “Clear” on the left and file on the right. Filenames are listed on the 

left and the file size is listed in the right column. An empty file will have a zero as the file size.  

 Use the up or down keys to select the file to clear.  

 Press the right arrow to clear the file.  

 Press Enter to confirm. 

 The display will indicate “Done!” when the file is erased.  

 Press Stop or the left arrow to go back to the File Menu.  

  

Clear                                   File 

File01                                 3201 

RoomA2                            1022 

Fruit7                                        0 
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Delete a File 
Press the right arrow when “Delete” is highlighted on the display to get the unit into the File > 

Delete Menu. This mode will erase a file (and filename) completely from the SD card. In this mode, 

the top line of the display reads “Delete” on the top left line and “File” on the right. Below this, the 

filename is listed on the left and the file size is listed on the right.   

Delete                                  File 

File01                                 3201 

RoomA2                            1022 

Fruit7                                        0 

 

 To delete a file, use the up or down arrow keys to select a file.    

 Once a file is selected to be deleted, press the right arrow key to delete the file.   

 Press Enter to confirm. Or, to escape without deleting the file, press the left arrow or Stop 

key. 

 The display will indicate “Done!” when the file is erased.  

 Press Stop or the left arrow to go back to the File Menu.  

 

Create a File 
Press the right arrow when “Create” is highlighted on the display to get the unit into the File > 

Create Menu. The top line of the screen will read “Name” on the left, and a file name (e.g. “file00”) 

on the right.  

 

Name:                               file00 

ENTER TO CREATE A FILE 

STOP TO CANCEL 

 NOTE:  The Stop key can be pressed at any time to abort the file creation process and to 
return to this point. 

 
Pressing the arrow keys will allow the user to enter an alpha or numeric selection for a six-

character file name. The right/left arrow keys select which character in the file name to edit and the 

up/down arrow keys are used to choose a character.  
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The chart lists the available characters. Although special characters are seen as options while 

creating a filename, it is currently recommended not to use special characters when naming files. 

The filename must end in a number, or else the file will be corrupt and no data will be saved to it.  

 

 

 

 

Pressing the Save key in the "Create" mode saves the file. Should the file name be identical to 

another file name, the instrument will display the message “duplicate name” on the top line of the 

display and “enter” on the bottom.    

 

 

 

The F-900 will save all parameters for each measurement on the SD card. Once finished creating the 

file name, press the Enter key, or press Stop to abort the process. The F-900 will exit to the File 

Menu.  

Open File 
Press the right arrow when “Open” is highlighted on the display to get the unit into the File > Open 

Menu. The top line of the screen will read “Open” on the left, and “File” on the right. Filenames are 

listed on the left and the file size is listed in the right column.  

The default file on the instrument is File01. Data will be saved into File01 unless another file is 

created and opened. Data can be appended to the end of a file, so files that were previously used can 

be re-opened.  

Open                                     File 

File01                                 3201 

RoomA2                            1022 

Fruit7                                        0 

Fruit9                                       -2 

 

An empty file will have a zero as the file size. If the file is corrupt, the file size will be a negative 

number. Any file with a negative file size should be deleted and re-created. Only files with positive 

numbers or a zero for the file size can be opened to save data too.  

 

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z  

a b c d e f g h i j k l m n o p q r s t u v w x y z  

0 1 2 3 4 5 6 7 8 9 

Fruit01                           Create 

<enter>                          <stop> 
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 Use the up or down keys to select the file to open.  

 Press the right arrow to open the file. “Done!” will flash across the screen if the file was 

opened successfully.  

 Press Stop or the left arrow to go back to the File Menu.  

 Moving the cursor to another file after opening a file and then exiting the menu by pressing 

either Stop or the left arrow opens the second file (the last file highlighted on the menu is 

opened). 

 Note: After a file is created, it must be opened in order to start saving data to it.  

 

Data Transfer to a Computer  
To view the collected data on a computer, remove the SD card and insert it in an SD card reader on 

the computer. Or, use the supplied USB cable and connect the instrument to the USB host 

(computer). The user can only view/manipulate data on a computer via the USB connection, or with 

the removable SD card. Data cannot be viewed after it is saved on the F-900. 

Once the instrument is connected to the computer via USB cable, it is strongly recommended that 

the user copy and re-save the files and images to the hard drive of the computer. The computer 

application used to view the files can also be used to re-save them. It is recommended that the user 

does not work from the original file on the SD card after the measurement has been made, because 

if any changes are made to the original file, it can break the alignment of the file causing error and 

data loss. 

In order to keep the file system in sync, perform any editing or further calculations on the copied 

file saved to the computer hard drive. Do not edit the files directly on the SD card! 

Do not connect the USB cable to the instrument and the computer while performing measurements. 

If the user tries to operate the instrument through the computer, the files are subject to becoming 

out of sync, breaking alignment and causing errors in the files. This can also lead to problems with 

saving data. 

If an error occurs in a specific data file, it can be deleted and created again. Go to the File Menu on 

the instrument; clear the file where the error has occurred. If the file has been transferred to the 

computer, delete it on the computer also. Once the corrupted files have been deleted, create the file 

again (if it has been properly cleared, the same file name can be used) and re-take the 

measurement.  
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Data Files  

Open the data files saved on the SD card on the computer using Microsoft Excel or Notepad. The 

figure below is an example data spreadsheet. Data values included are the date and time of the 

measurement, the ethylene level in ppm, the mode (monitor, measure or cleaning, offset or GC 

emulation), the CO2 and O2 concentration, the temperature of the gas stream in degrees Celsius, the 

relative humidity (RH) of the gas stream in percent, the atmospheric pressure (KPa) and the flow 

rate of the gas stream in ml/min. In this example, when the CO2 or O2 sensors are not being used, 

the concentration values are zero. For the mode, monitor indicates measurements without 

PolarCept, sm_measure or sm_clean indicate PolarCept, and offset indicates zero calibration.   

 
Figure 24: Example data spreadsheet for a F-900 measurement.  
 

REMEMBER: Always save the data files to the computer before making changes or starting analysis.  

  



F-900 Instruction Manual 5/8/2017 

1554 NE 3rd Ave, Camas, WA 98607, USA                   Phone: (360) 833-8835 60 
sales@felixinstruments.com                                         www.felixinstruments.com 

Below is an example of ethylene data plotted for PolarCept, that shows the typical peaks and valleys 

for the measure/cleaning cycle. At the end of the cleaning time, the ethylene level should be low 

(below 0.2 ppm). If a low ethylene concentration is not seen at the end of the cleaning period, 

lengthen the Cleaning period in Setup > Chamber > Chamber In = Special and test again.  

 
 

Figure 25: Example of ethylene data graphed showing peaks/valleys for measure and 
cleaning periods.   
 

Wireless SD Memory Card Operation 
These instructions are meant to accompany the instructions supplied by the vendor for Toshiba 

FlashAir™ W-03 to use specifically with the F-920 Check It! Gas Analyzer, which can be similarly applied 

to other Felix Instruments products. 

1. Install FlashAir™ Wi-Fi card software appropriate to the SD card. 

a. Visit https://www.toshiba.co.jp/p-media/english/download/wl/software02.htm to 

download the software for configuring the Wi-Fi card and obtain vendor operation 

instructions. 

2. Insert the Wi-Fi card onto a personal computer (PC). 

3. Open the “FlashAirTool” on your PC to configure the SD card. 

4. Follow the configuration instructions prompted by the “FlashAirTool”. 

5. For additional guidelines, access the “Help” menu inside the “FlashAirTool” software. 

https://www.toshiba.co.jp/p-media/english/download/wl/software02.htm
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6. The Wi-Fi card can be enabled in “internet pass thru mode”, outlined in the following 

documentation provided within the FlashAirTool software: 

• Go to Network Settings on the main menu 

Check Internet pass thru mode 

This function is available for FlashAir™ W-03 and FlashAir™ W-02 (Ver. 

F19BAW3AW2.00.02 or later) cards. 

 

When this function is enabled, the FlashAir™ card can be used like a router, by allowing 

another access point to be connected via the card. 

When an internet access point is connected, images stored on the FlashAir™ card can be 

viewed, and the internet can also be accessed. 

This is convenient when, for example, uploading image files downloaded form a 

FlashAir™ card onto social networking services, as there is no need to change the Wi-fi 

device network settings on your smartphone. 

 

 

* CAUTION: If you want to connect to the internet without using the internet pass thru mode, the 

wireless LAN setting connection on 

your smartphone or other device must be changed from the FlashAir™ card to the 

internet access point. 

Check the “Enable internet pass thru mode” checkbox to enable “internet pass thru 

mode”.  

o Access Point SSID 

Sets the SSID of the internet access point. 

Enter the SSID for the access point that you will use. An SSID of up to 32 

alphanumeric characters can be entered. 
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o Access Point Password 

Set the internet access point password. 

Enter the password for the access point that you will use. 

o In your browser, enter http://flashair to view or stream your files 

 

For more information on the Toshiba FlashAir™ W-03 Wireless SD Memory Card, contact the 

application vendor at https://www.toshiba.co.jp/p-media/wwsite/contact.htm. 

  

http://flashair/
https://www.toshiba.co.jp/p-media/wwsite/contact.htm
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Firmware Update 
Transfer all data files from the SD card and DELETE all data files on SD card before doing the 

firmware update! Leaving data files from older firmware versions may corrupt the SD card. 

Several files should be accessed from the software CD or downloaded from the F-900 support 

webpage (https://felixinstruments.com/support/F-900/) under software. Always double-check the 

webpage for the latest compatible firmware version depending on the serial number of the F-900. 

Please contact Felix Instruments technical support with questions about firmware updates. 

• Setup application: F-900_Package_Setup_v1.0.exe  

• Firmware code file: F-900-ver-x.xx.bin (Example: F-900-ver-4.6.1.bin) 

F-900 Driver Installation Procedure 

1. Connect the F-900 to the computer using the mini-USB to USB cable.  

2. Launch F-900_Package_Setup_v1.0.exe  

3. Set up device as prompted message below 

 

4. The F-900 requires an libusb driver. In the Zadig window, select Options > List All Devices.  

 

  

https://felixinstruments.com/support/F-900/
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5. In the dropdown list, select CI-DFU (Interface 1) device. 

 

6. At the spinner list (green arrow), select libusb-win32. 

 

7. Click Install Driver to proceed installing libusb driver. This could take up to 1 minute to 

complete. 

Note: Wait for Windows “obtaining driver” process to complete before clicking Install driver.  
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8. When the device drivers and software package installation is done, check for Java updates. In 

the Windows Start menu, there will be shortcuts for F-900 Controller and F-900 Firmware 

Upgrade.  

 

 

 

F-900 Firmware Update Procedure 

1. After installing the driver, open the F-900 Firmware 

Upgrade application: “Transfer Code to CI-203 or CI-

900.” 

2. If device is on, press the Power button to power off the 

device. Hold the down arrow button, then press the 

Power button. The device's internal green LED near the 

USB port/SD card should start flashing quickly. The 

device must be unplugged for this to work.  

3. After the green LED is flashing quickly, connect the device 

to the PC with USB cable.  

4.  Select File and Open in the F-900 Firmware Upgrade 

program. 

5. Navigate to where the F-900-ver-x.xx.bin is saved on the 

PC hard drive. This is the code for the instrument.  

6. Follow the instructions in the software to hold down the Power button.  

7. Release the Power button when instructed. 

8. Wait for the flash to be erased and then written. When the firmware transfer is complete, 

the software will indicate reset sent, followed by “leaving open”. The F-900 will power off. 
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9. Power on the F-900 and check the firmware version at 

the top of the display. The Transfer Code software 

application will indicate that no instrument is found, if 

the F-900: 

A. is not connected to the computer 

o verify USB connection and LED is flashing  

B. is not powered on 

o verify on device display 

C. driver is not properly installed  

o install or re-install F-900 driver 

 

If the F-900 becomes unresponsive or frozen during the firmware update, especially when using 

Windows 8, please try the following: 

1. Hold the power button for 10 seconds and let go. 

2. Hold the down arrow button then press power button, device's internal green LED near USB 

port/SD card should start flashing quickly 

3. Connect the device to computer via USB and repeat the download firmware procedure. 

 

After the firmware update is successful, it is recommended to let the F-900 measure with the 

Closed Loop On (Measure > Settings) for 12 hours. 
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Technical Support 
If you have a question about the F-900, first look in the F-900 Operation Manual. There is also 

online support available for the F-900 at http://felixinstruments.com/support/f-900-support. If 

you cannot find the answer, you can contact a Technical Support Representative located in your 

country. Felix Instruments is committed to providing customers with high quality, timely technical 

support. Technical support representatives are there to answer your technical questions by phone 

or by e-mail at support@felixinstruments.com, please use your instrument’s serial number as the 

subject line when sending a support request by email.  

 

Felix Instruments contact information:  

 
Felix Instruments-Applied Food Science. 

1554 NE 3rd Ave 
Camas, WA 98607 USA 

 
Phone: 800-767-0119 (U.S. and Canada) 

360-833-8835 
Fax: 360-833-1914 

 
Internet: http://www.felixinstruments.com 

E-mail: support@felixinstruments.com 
 

http://felixinstruments.com/support/f-900-support
mailto:support@felixinstruments.com
mailto:support@felixinstruments.com
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Frequently Asked Questions 
If there are any questions about the F-900, please check the Frequently Asked Questions below, as 

well as the Felix Instruments support webpage at http://felixinstruments.com/support/f-900-

support.  

1. What type of fruit produces ethylene? 

a. Climacteric fruits refer to fruits that have high respiration rate during the fruit's 

ripening. During the ripening process of climacteric fruits, the production of a 

phytohormone, ethylene, dramatically increases up to 1000-fold of the basal 

ethylene level. Climacteric fruits are ones that are able to ripen after being 

picked. An example of climacteric fruit is bananas; they are picked and shipped 

green and then ripen at a later time (often in the store or home). Climacteric 

fruits include, but are not limited to, apples, apricots, avocados, bananas, 

cantaloupes, figs, guavas, kiwis, mangoes, nectarines, peaches, pears, 

persimmons, plums, and tomatoes. [Source: Wikipedia.com] 

2. What should I do if I see moisture develop in the tubing when monitoring a fruit in the 

chamber? 

a. There is a protective hydrophobic filter inside the IN port on the front of the F-

900. This will prevent moisture from fully entering the instrument. Silica gel in a 

conditioning chamber can be used to dry out the gas stream, either before or 

after the gas passes the electrochemical sensor. Refer to the flow path diagram 

in the Setup>Chamber section of the User Manual for more information.  

3. Can the data output be directly linked to the computer, and by what type of connection 

can be used? And is it MAC and/or PC compatible? 

a. The unit has an SD card and the format can be read on any Mac or PC. Data can 

also be downloaded via USB. The F-900 Controller software is used when 

connecting to a PC to view real-time data (see page 28 for more details.) 

4. How do I change how the data appears in the .csv file? 

a. If data isn't displaying properly, try saving the file as a .csv file type and re-

opening it. If saving as a .csv does not fix how the data is displayed, you may 

need to change the separator value on your computer.  

To change the separator in all .csv text files: 

1. In Microsoft Windows, click the Start button, and then click Control Panel. 

2. Open the Region and Language Options dialog box. 

3. Do one of the following: 

http://felixinstruments.com/support/f-900-support
http://felixinstruments.com/support/f-900-support
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a. In Windows Vista and 7, click the Formats tab, and then click 

Customize this format. In Windows 7 click the "additional settings" 

button to get to the option to change the separator. 

b. In Windows XP, click the Regional Options tab, and then click 

Customize. 

4. Type a new separator in the List separator box. For example, type "," 

5. Click OK twice. 

NOTE: After you change the list separator character for your computer, all programs 

use the new character as a list separator. You can change the character back to the 

default character by following the same procedure. 

5. How do I create and open a file to start using the F-900? 

a. To start using the F-900, create a file to save data into. Go to File>Create. Change 

the file00 to the desired file-name and press save. Next, open the file to save 

measurements. Go to File>Open and use the arrows to highlight the newly 

created file. If the value next to the file-name is a negative number, this indicates 

an error. You should delete the file and create it again. Then, open it and check 

that the value is zero. Now, you can save data into this file. 

6. What consumables come with the F-900? 

a. The F-900 and F-900RK ship with potassium permanganate (KMnO4), an 

ethylene scrubber (Purafil Fresh Air Sachets). KMnO4 is sold at many Home and 

Garden stores and online. The pellet (vs. crystal or powder) form of KMnO4 

is recommended. http://www.producefreshies.com/ is an online source. 

b. The F-900RK also ships with a humidity scrubber (silica gel). If the F-900 

includes an optional CO2 sensor, soda lime is provided as a CO2 scrubber. 

Carolina Biological (www.carolina.com) is an online source for soda lime and 

silica gel.  

7. What are some possible applications for the F-900? 

a. The F-900 could be used to help optimize Controlled Atmosphere Storage 

Rooms and prevent losses. Ethylene is an important and sensitive marker for 

ripening of fruits. Other postharvest research applications are possible. 

b. In addition to plants, some microorganisms, including fungi and bacteria, 

synthesize ethylene. Microorganisms can cause great losses in the postharvest 

industry through disease and mold, so research into ethylene and the pathogen-

host interaction is important. A common plant pathogen that produces ethylene 

is Botrytis cinerea. 

http://www.producefreshies.com/
http://www.carolina.com/
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c. Measuring ethylene concentration in the air of rooms where young apple trees 

in pots are stored adjacent to refrigerated apple storage rooms, in order to 

assess the safety to young apple trees. During the winter months, the safe level 

for storage of first year apple trees is below 50ppm. 

d. Commercial apple growers could monitor the ethylene levels of empty 

refrigerated rooms before storing bare-root nursery trees. Rooms should be 

empty of ethylene before storing nursery trees and often growers have no way 

to monitor this.  

e. Monitoring ethylene emission from industrial sources. Ethylene is of interest 

because it plays a role in atmospheric ozone chemistry. This will be dependent 

on interfering gas and the source of industrial emissions. 

8. How long does it take to recharge the battery? 

a. About four hours. The unit may be operated while the battery is charging. 

9. What happens if the cell runs out of water? 

a. If the cell runs out of water, the lead electrode could undergo sulfation. This 

would affect the sensitivity by reducing the active area on the lead electrodes. It 

is more likely that a lack of water in the cell decreases the activity of the 

electrolyte and increases the resistivity of the Nafion membrane. Both will affect 

the background current and response time of the cell. 

10. What are the advantages of the F-900RK over the standard F-900?  

a. Both are portable, but the research kit includes the other components as listed 

in the “Unpacking the F-900” section of the User Manual, such as the fruit 

chamber and wand and hard-sided, wheeled carrying case. The Research Kit is 

designed to make measurement of fruits non-destructively or in a closed 

chamber. Fans are built into the fruit chamber to mix the air.  

 

11. What are the most commons uses for Chamber In and Chamber Out? 

a. Both chambers are optional, but it is recommended to use Chamber In as 

PolarCept for most measurements. The most common use for Chamber In is to 

separate light hydrocarbons, such as alcohol, from the gas stream which may 

interfere with the measurement. The most common use for Chamber Out is to be 

filled with potassium permanganate, so that it cleans all ethylene and other 

hydrocarbons from the gas stream, so that any ethylene that is measured must 

have come from the sample. Chamber Out is also commonly used with KMnO4 to 

calibrate the zero of the ethylene sensors.  
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12. During a monitoring experiment, will the sealed fruit chamber influence the result as 

time goes on?  

a. The air should be scrubbed by enabling conditioning Chamber Out (filled with 

potassium permanganate). Attach the tubing from the wand that returns to the 

fruit chamber to the Out port on the front of the F-900.  

13. Where are temperature and humidity measured? 

a. The temperature and relative humidity sensors are located inside the F-900, 

before the electrochemical sensor. There is an additional relative humidity 

sensor after the ethylene sensor to help track water loss. 

14. What is the emission rate of ethylene from the fruit, taking into account the weight of 

the fruit (or sample) and the time measured? 

a. Flow rate: 0.2L/min = 12.0L/hr 

Sensitivity of C2H4 PPM sensor to C2H4: 0.1 µL/L or 100 nL/L 

Therefore, the F-900 optimally detects around 1200 nL/hr. The unit is 

nanoliters of ethylene per gram fresh weight per hour.  

 

15. What types of tubing materials have been found to outgas? 

a. Several types of material have been found to outgas interfering gases of the 
ethylene sensor, such as Tygon. Viton and Teflon have successfully been found 
to not outgas.  
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APPENDIX I: Material Safety Data Sheet for 2N Sulfuric Acid 

Solution 

SECTION 1: CHEMICAL PRODUCT AND COMPANY IDENTIFICATION 
Product Name: Sulfuric Acid, 2N 
Catalog Codes:  
CAS#: Mixture. 
RTECS: Not applicable. 
TSCA: TSCA 8(b) inventory: Sulfuric acid; Water  
CI#: Not applicable. 
Synonym: 
Chemical Name: Not applicable. 
Chemical Formula: Not applicable. 
 
Contact Information: 

Felix Instruments-Applied Food Science 
1554 NE 3rd Ave 
Camas, WA 98607 USA 
Phone: 1-800-767-0119  
(U.S. and Canada): 1-360-833-8835 

 
CHEMTREC (24HR Emergency Telephone), call: 1-800-424-9300 
International CHEMTREC, call: 1-703-527-3887 
For non-emergency assistance, call: 1-281-441-4400 

 

SECTION 2: COMPOSTION AND INFORMATION ON INGREDIENTS 
Composition: 

Name CAS # % by Weight 

Sulfuric acid 7664-93-9 9.8 

Water 7732-18-5 90.2 

 
Toxicological Data on Ingredients: Sulfuric acid: ORAL (LD50): Acute: 2140 mg/kg [Rat.]. VAPOR (LC50): Acute: 255 ppm 4 
hour(s) [Rat.]. 

SECTION 3: HAZARDS IDENTIFICATION 
Potential Acute Health Effects: 
Extremely hazardous in case of skin contact (corrosive, irritant), of eye contact (irritant), of ingestion, of inhalation. Liquid or 
spray mist may produce tissue damage particularly on mucous membranes of eyes, mouth and respiratory tract. Skin contact 
may produce burns. Inhalation of the spray mist may produce severe irritation of respiratory tract, characterized by coughing, 
choking, or shortness of breath. Inflammation of the eye is characterized by redness, watering, and itching. Skin inflammation is 
characterized by itching, scaling, reddening, or, occasionally, blistering. 
 
Potential Chronic Health Effects: 
Extremely hazardous in case of skin contact (corrosive, irritant), of eye contact (irritant), of ingestion, of inhalation. 
Nonsensitizer for skin. Non-permeator by skin. CARCINOGENIC EFFECTS: Not available. MUTAGENIC EFFECTS: Not available. 
TERATOGENIC EFFECTS: Not available. DEVELOPMENTAL TOXICITY: Not available. The substance is toxic to lungs, mucous 
membranes. Repeated or prolonged exposure to the substance can produce target organs damage. Repeated or prolonged 
contact with spray mist may produce chronic eye irritation and severe skin irritation. Repeated or prolonged exposure to spray 
mist may produce respiratory tract irritation leading to frequent attacks of bronchial infection. Repeated or prolonged 
inhalation of vapors may lead to chronic respiratory irritation. 
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SECTION 4: FIRST AID MEASURES 
Eye Contact: 
Check for and remove any contact lenses. Immediately flush eyes with running water for at least 15 minutes, keeping eyelids 
open. Cold water may be used. Do not use an eye ointment. Seek medical attention. 
 
Skin Contact: 
If the chemical got onto the clothed portion of the body, remove the contaminated clothes as quickly as possible, protecting 
your own hands and body. Place the victim under a deluge shower. If the chemical got on the victim's exposed skin, such as the 
hands: Gently and thoroughly wash the contaminated skin with running water and non-abrasive soap. Be particularly careful to 
clean folds, crevices, creases and groin. Cold water may be used. If irritation persists, seek medical attention. Wash 
contaminated clothing before reusing. 
 
Serious Skin Contact: 
Wash with a disinfectant soap and cover the contaminated skin with an anti-bacterial cream. Seek medical attention. 
Inhalation:  
Allow the victim to rest in a well ventilated area. Seek immediate medical attention. 
 
Serious Inhalation: 
Evacuate the victim to a safe area as soon as possible. Loosen tight clothing such as a collar, tie, belt or waistband. If breathing 
is difficult, administer oxygen. If the victim is not breathing, perform mouth-to-mouth resuscitation. WARNING: It may be 
hazardous to the person providing aid to give mouth-to-mouth resuscitation when the inhaled material is toxic, infectious or 
corrosive. Seek immediate medical attention. 
 
Ingestion: 
Do not induce vomiting. Loosen tight clothing such as a collar, tie, belt or waistband. If the victim is not breathing, perform 
mouth-to-mouth resuscitation. Seek immediate medical attention. 
Serious Ingestion: Not available. 

SECTION 5: FIRE AND EXPLOSION DATA 
Flammability of the Product: Non-flammable. 
Auto-Ignition Temperature: Not applicable. 
Flash Points: Not applicable. 
Flammable Limits: Not applicable. 
Products of Combustion: Not available. 
Fire Hazards in Presence of Various Substances: Not applicable. 
Explosion Hazards in Presence of Various Substances: 
Risks of explosion of the product in presence of mechanical impact: Not available.  
Risks of explosion of the product in presence of static discharge: Not available. 
Fire Fighting Media and Instructions: Not applicable. 
Special Remarks on Fire Hazards: Not available. 
Special Remarks on Explosion Hazards: Not available. 

SECTION 6: ACCIDENTAL RELEASE MEASURES 
Small Spill:  
Dilute with water and mop up, or absorb with an inert dry material and place in an appropriate waste disposal container. If 
necessary: Neutralize the residue with a dilute solution of sodium carbonate. 
 
Large Spill: 
Corrosive liquid. Stop leak if without risk. Absorb with DRY earth, sand or other non-combustible material. Do not get water 
inside container. Do not touch spilled material. Use water spray curtain to divert vapor drift. Prevent entry into sewers, 
basements or confined areas; dike if needed. Call for assistance on disposal. Neutralize the residue with a dilute solution of 
sodium carbonate. Be careful that the product is not present at a concentration level above TLV. Check TLV on the MSDS and 
with local authorities. 
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SECTION 7: HANDLING AND STORAGE 
Precautions: 
Keep container dry. Do not breathe gas/fumes/ vapor/spray. Never add water to this product In case of insufficient ventilation, 
wear suitable respiratory equipment If ingested, seek medical advice immediately and show the container or the label. Avoid 
contact with skin and eyes Keep away from incompatibles such as alkalis. May corrode metallic surfaces. Store in a metallic or 
coated fiberboard drum using a strong polyethylene inner package. 
 
Storage: 
May corrode metallic surfaces. Store in a metallic or coated fiberboard drum using a strong polyethylene inner package. 
Corrosive materials should be stored in a separate safety storage cabinet or room. 
 

SECTION 8: EXPOSURE CONTROLS/PERSONAL PROTECTION 
Engineering Controls: 
Provide exhaust ventilation or other engineering controls to keep the airborne concentrations of vapors below their respective 
threshold limit value. 
 
Personal Protection: 
Face shield. Full suit. Vapor respirator. Be sure to use an approved/certified respirator or equivalent. Gloves. Boots. 
 
Personal Protection in Case of a Large Spill: 
Splash goggles. Full suit. Vapor respirator. Boots. Gloves. A self-contained breathing apparatus should be used to avoid 
inhalation of the product. Suggested protective clothing might not be sufficient; consult a specialist BEFORE handling this 
product.  
 
Exposure Limits: 
Sulfuric acid TWA: 1 STEL: 3 (mg/m3) from ACGIH Consult local authorities for acceptable exposure limits. 

 

SECTION 9: PHYSICAL AND CHEMICAL PROPERTIES 

Physical state and appearance: Liquid. 
Odor: Odorless. 
Taste: Not available. 
Molecular Weight: Not applicable. 
Color: Clear Colorless. 
pH (1% soln/water): 2 [Acidic.] 
Boiling Point: The lowest known value is 100°C (212°F) (Water). 
Melting Point: Not available. 
Critical Temperature: Not available. 
Specific Gravity: The only known value is 1 (Water = 1) (Water). 
Vapor Pressure: The highest known value is 17.535 mm of Hg (@ 20°C) (Water). 
Vapor Density: The highest known value is 0.62 (Air = 1) (Water). 
Volatility: Not available. 
Odor Threshold: Not available. 
Water/Oil Dist. Coefficient.: The product is much more soluble in water. 
Ionicity (in Water): Not available. 
Dispersion Properties: See solubility in water. 
Solubility: Easily soluble in cold water, hot water. Insoluble in methanol, diethyl ether, n-octanol. 

SECTION 10: STABILITY AND REACTIVITY DATA 
Stability: The product is stable. 
Instability Temperature: Not available. 
Conditions of Instability: Not available. 
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Incompatibility with various substances: 
Extremely reactive or incompatible with alkalis. Slightly reactive to reactive with metals. 
 
Corrosivity: 
Extremely corrosive in presence of aluminum, of zinc. Highly corrosive in presence of steel, of copper. Slightly corrosive to 
corrosive in presence of stainless steel(304), of stainless steel(316). Non-corrosive in presence of glass. 
 
Special Remarks on Reactivity:  
Reacts violently with water especially when water is added to the product. (Sulfuric acid) 
 
Special Remarks on Corrosivity: Not available. 
Polymerization: No. 

SECTION 11: TOXICOLOGICAL INFORMATION 
Routes of Entry: Eye contact. Inhalation. Ingestion. 
Toxicity to Animals: LD50: Not available. LC50: Not available. 
 
Chronic Effects on Humans: The substance is toxic to lungs, mucous membranes. 
Other Toxic Effects on Humans: Extremely hazardous in case of skin contact (corrosive, irritant), of ingestion, of inhalation. 
 
Special Remarks on Toxicity to Animals: Not available. 
Special Remarks on Chronic Effects on Humans: Not available. 
Special Remarks on other Toxic Effects on Humans: Not available. 

 

SECTION 12: ECOLOGICAL INFORMATION 
Ecotoxicity: Not available. 
BOD5 and COD: Not available. 
 
Products of Biodegradation: 
Possibly hazardous short term degradation products are not likely. However, long term degradation products may arise. 
 
Toxicity of the Products of Biodegradation: The products of degradation are more toxic. 
Special Remarks on the Products of Biodegradation: Not available. 
 

SECTION 13: DISPOSAL CONSIDERATIONS 
Waste Disposal: 

SECTION 14: TRANSPORT INFORMATION 
DOT Classification: CLASS 8: Corrosive liquid. 
Identification: Sulfuric acid, solution: UN2796 PG: II 
Special Provisions for Transport: Not available. 

SECTION 15: OTHER REGULATORY INFORMATION 
Federal and State Regulations: TSCA 8(b) inventory: Sulfuric acid; Water 
 
Other Regulations:  
OSHA: Hazardous by definition of Hazard Communication Standard (29 CFR 1910.1200). 
 
Other Classifications: 
WHMIS (Canada): 
CLASS D-2A: Material causing other toxic effects (VERY TOXIC). CLASS E: Corrosive liquid. 
DSCL (EEC): R35- Causes severe burns. 
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HMIS (U.S.A.): 
Health Hazard: 1 
Fire Hazard: 0 
Reactivity: 0 
Personal Protection: 
National Fire Protection Association (U.S.A.): 
Health: 1 
Flammability: 0 
Reactivity: 0 
Specific hazard: 
Protective Equipment: Gloves. Full suit. Vapor respirator. Be sure to use an approved/certified respirator or equivalent. Wear 
appropriate respirator when ventilation is inadequate. Face shield. 
 

SECTION 16: OTHER INFORMATION 
References: Not available. 
Other Special Considerations: Not available. 
Created: 12/21/2010 
Last Updated: 4/23/2012 
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APPENDIX II: Procedure for F-900 Validation Using Fruit 
The following methods should be run consecutively on a given replicate and repeated for each new 

replicate (new specimen). At least 5 replicates for pre-climacteric (un-gassed or still green) apples, 

bananas, or avocados should be run. The data from method 1 and 2 can be combined into a table. 

The results from method 3 can be graphed, as a figure, to show the trend over time.  

Method 1: Sampling with No Filtration/Trapping 
The purpose of this method is to determine what response the sensor has without trapping of 

interfering gases. This can be thought of as the baseline response  

Procedure:  

1. Turn on the F-900, verify chambers are set to off and flow is set to 200 ml/min.  

2. Connect experimental setup as shown in Figure 25.  

3. Load the sample specimen into the fruit chamber. 

4. Start measuring the fruit headspace with the F-900.  

5. After sampling the headspace for 5 minutes, or a set period of time of your choosing, take a 

syringe sample and run it in the GC (gas chromatograph). Record result in spreadsheet 

program, such as Microsoft Excel.  

6. Vent the fruit chamber, record the result in Microsoft Excel and start Method 2. The fruit 

chamber should be well vented to flush out any plant gases between measurements.  

Method 2: Sampling with Filtration/Trapping  
The purpose of this method is to determine what response the sensor has with trapping of 

interfering gases by H2O. This can be thought of as the effect to the instantaneous measurement.  

Procedure:  

1. Fill conditioning Chamber In with distilled water and clean the water using potassium 

permanganate in an in-line column connected to the intake port of the F-900, until the 

background signal is below 20ppb.  

2. Load the sample specimen into the fruit chamber. 

3. Start measuring the fruit headspace with the F-900.  

4. After sampling the headspace for exactly 5 minutes, take a syringe sample and run it in the 

GC (gas chromatograph). Record result in spreadsheet program, such as Microsoft Excel.  

5. Vent the fruit chamber, record the result in Microsoft Excel and start Method 3.  



F-900 Instruction Manual 5/8/2017 

1554 NE 3rd Ave, Camas, WA 98607, USA                   Phone: (360) 833-8835 80 
sales@felixinstruments.com                                         www.felixinstruments.com 

Method 3: Long-Term Monitoring with Filtration  
The purpose of this method is to determine the effectiveness of the PolarCept filter for long term 

measurements. This will require the trap to self-regenerate between consecutive measurements. 

The regeneration time is defaulted to 6 minutes; however for some species a greater time may be 

needed. By keeping the default value for avocados, we can better compare results and will 

demonstrate the weakness of the method and how to realize if the “cleaning” period should be 

extended. 

Procedure:  

1. Fill conditioning Chamber In with distilled water and clean the water using potassium 

permanganate in an in-line column connected to the intake port of the F-900, until the 

background signal is below 40ppb.  

2. Verify that Chamber In is set to “Special” with a sufficient cleaning period for the produce 

being monitored.  

3. Load the sample specimen into the fruit chamber.  

4. Start measuring the fruit headspace with the F-900.  

5. Allow the system to run for 5 measurement and cleaning cycles.  

6. Vent the chamber and load the data file to a computer.  

7. Switch to the next replicate and begin at Method 1 again.  

 

 

 

 

 

Figure 25: Set-up for fruit chamber using (KMnO4) to scrub ethylene from the outside air. 
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APPENDIX III: Guidelines for Measuring Sample Bags 
The following guidelines are for collecting air samples in standard samples bags. In order to collect 

an air sample, you must pump air into the bag (pump not included). These bags are often used to 

collect ambient air samples to analyze later in a laboratory, using a gas chromatograph, or can be 

connected to the F-900 using the accessory parts.  

 Ensure that the bag material and fittings are appropriate for the compounds to be sampled. 

 Use only Teflon or Viton tubing to connect the sample bag to the pump to prevent sample 
loss by adsorption on tubing walls. 

 Before using, flush the bag thoroughly with purified air or nitrogen. 

 Analyze the sample within 24 to 48 hours. Long-term storage of air-contaminant mixtures 
in bags is not recommended. 

 Do not ship sample bags by air unless the cargo cabin is pressurized.  

 Do not overfill sample bags. 

 Secure polypropylene value when opening/closing by holding side stem while turning 
entire upper portion of fitting one revolution. 

 Store bags flat. Do not roll or crease bags during storage. 

 Do not use bags at temperatures above 140 OF (60 OC). 

 Bags are designed for single use only. 

 

To Collect a Sample Using a Sample Bag 

1. Flush the bag at least 3 times with purified air or nitrogen before use. 

2. To fill a bag, connect tubing from the exhaust port of an air sample pump to the hose 
connection on the bag (stem protruding from the side of the fittings). 

3. To open the shut-off valve, hold the side stem and turn the entire upper portion of the 
fitting (including the brown syringe port and the white section to which it is attached) 
counterclockwise one revolution. Turn on the pump and sample. 

4. Avoid filling any bag more than 80% of its maximum volume. 

5. When sampling is complete, turn off the pump. To close the shut-off valve, hold the side 
stem and turn the entire upper portion of the fitting clockwise until it is snug. 

6. To withdraw samples using a needle and syringe, carefully insert the needle into the septum 
port in the center of the brown cap and pierce the septum. Do not allow the needle to 
puncture the bag material when piercing the septum.  

7. Do not use the fitting valve as a handle or hanging device. Although it is durable, it is not 
intended for these uses.  
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Analyzing a Sample Bag with the F-900 

 Connect the sample bag to the IN port of the F-900.  

 Open the sample bag to allow gas to start flowing to the F-900.  

 It takes about 3-5 minutes to measure a sample bag if the concentration of ethylene 

before measuring the sample bag is low. 

APPENDIX IV: 8L Chamber Accessory 
These visuals supply the user with the basic Do’s and Don’ts of working with the 8L Chamber 

accessory. Designed for measuring samples in a closed system, the 8L chamber can easily attach to 

the inlet and outlet on the F-900 to monitor ethylene, carbon dioxide and oxygen accumulation. 
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APPENDIX V: F-900 Controller Software for Calibration 
The F-900 Controller software is designed to make calibration quick and easy, with many 

automated features. (Requires latest version of Java). A major advantage of using the F-900 

Controller software to calibrate the sensors is that all calibration parameters are updated and saved 

in the F-900, including calibrated RH, calibrated T, and internal gain. Additionally, compensation for 

temperature and relative humidity are automatically applied, based on the internal sensors of the 

F-900. The F-900 Controller software is primarily used for the C2H4 PPB sensor span calibration, 

which is recommended weekly.   

Other sensors on the F-900 can be calibrated using the F-900 Controller software. The calibration of 

the RH sensor requires an external relatively humidity sensor. Each sensor must have the zero 

calibration set before carrying out the span calibration. This can be carried out with KMnO4 

and the “set zeros” calibration for ethylene, or for “set zero” of CO2 and O2 sensors by using N2 gas 

and the F-900 Controller software (step #1 in the F-900 Controller software “Calibration” tab).  

The CO2 PCT is calibrated at 3 known points and 0 ppm to provide the greatest accuracy for the 0-

20% range. When recalibrating the CO2 PCT sensor, choose the expected or desired range and 

calibrate with the recommended concentration. If using the 0-100% CO2 range, values above 20% 

are extrapolated and not measured due to the limitation of the sensor range. Verify with CO2 gas 

within expected range. The following table indicates what concentration of calibration gas is used at 

Felix Instruments for each sensor. Please refer to calibration prerequisites on pg. 

ef472597714 28.  

Ethylene Sensor Span Calibration 
Refer to the Specification on page Specifications3 for the calibration schedule as well as Table 1 on 

page 28. 

Before performing a span calibration:  

1. First perform a zero calibration  

2. The F-900 driver must be downloaded and installed using the F-900 Package Setup v1.X.exe 

found on the webpage (http://felixinstruments.com/support/f-900-support/software), as well as 

detailed instructions. The F-900 Package Setup includes the F-900 Controller software necessary 

for the calibration. 

Set C2H4 PPB Span 

1. Connect the F-900 to the PC using the USB cable. Power on the F-900 and open the F-900 

Controller software (Latest version of Java required. Check http://www.java.com/) 

a. If the F-900 display becomes frozen consistently when connecting to the PC, it is 

possible the SD card is corrupted. To repair, insert the SD card in the computer.  If 

the PC reports disk error, choose "scan and fix". If not right click on the SD card 

drive > Properties > Tools > Scan. Press and hold the power button for 10 seconds to 

force a shut-off if the F-900 freezes.  

http://felixinstruments.com/support/f-900-support/software
http://www.java.com/
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2. The device serial number should appear in the upper left corner of the F-900 Controller 

software and a message should appear indicating that the device is connected in USBHID 

mode. Click on the device serial number to connect to that specific instrument.  The F-900 

Controller software can have more than 1 device connected at a time.   

 

3. On the F-900, navigate to Measure and press the right arrow to begin a measurement. 
Press the right arrow again to skip the sensor stabilization.  

a. There is a short lag in the F-900 Controller software as it pulls data from the F-900 
instrument. This lag interval is adjustable in 1 second intervals. The monitor view 
data should begin to appear and update in the F-900 Controller software, including 
ethylene, temperature, RH, flow rate, and CO2 or O2 if optional sensors are enabled.   
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4. Select the “Calibration” tab in the F-900 Controller software. Select the tab for “F-900” to see 

the various calibrations possible (Zero individual sensors with N2, Relative Humidity (RH), 

O2 Span, CO2 Span, C2H4 Span.) 

5. See the last calibration listed: C2H4: Use C2H4 standard.  

a. Select C2H4 PPB to calibrate the ppb sensor.   

 
6. Enter the exact ethylene concentration from the calibration standard gas in ppb (ex: 1555 

ppb) in the F-900 Controller software.  
7. Connect the standard gas to the F-900 intake.  Verify that the F-900 measurement settings 

have Chamber In, Chamber Out and Closed Loop turned off.  
8. Watch the ethylene data on the F-900 Controller software now that the standard gas is 

connected. The data should be trending towards the expected concentration and begin to 
stabilize.   
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9. Wait at least 7 minutes once the signal has stabilized (and does not change more than 
40 ppb) before setting the span calibration.  To set the span calibration, verify the correct 
concentration is entered in ppb in the F-900 Controller software and click the “set span” 
button. Note the value below has stabilized at 1.311 ppm.  
 

  
10. Once the set span button is pressed, the span concentration (ex: 1.555 ppm) should appear 

on the F-900 display as well as in the F-900 Controller software.  The concentration level 
should remain at stable values after setting the span.  
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11. Disconnect the calibration gas and watch the data trend toward ambient ethylene levels.  
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Guide for Purchasing Standardized Gases for Calibration 
When deciding which standard gases to purchase for calibration, there are some important 

considerations that will help guide your purchase: 

1) Determination of concentration of the gas to be purchased. The concentration of the 

standard gas is the first consideration. It needs to be at a concentration level that is 

appropriate for calibration of the instrument.  

 

2) Determination of proper regulator for the standard gas tank. A regulator is needed to 

provide a consistent flow of gas to the instrument at a certain rate. At our facility, we use 

on-demand regulators that require the pumps within our instruments to pull the gas from 

the standardized tank. If this is not an option, other regulators are acceptable, just use a T-

junction when connecting to the instrument to protect the instrument from damage.  

 

3) Determination of the size of tank to order. Consider how many calibrations can be 

performed with the volume of gas purchased. Each calibration for the F-920, 940, and 960 

will take around 0.3 liters of standard gas.  

Below is an example of a standard order our company would make to Air Liquide for a 1.5ppm ethylene 

standardized gas tank for calibration of the F-940. 

Air Liquide is a multi-national company that can deliver products to most business locations worldwide.  

You may look at www.airliquide.com for your local office. 

Air Liquide America Specialty Gasses LLC  

Telephone 425-931-8303 or 800-814-4642 

A sample order for 34 Liter canister of appropriate calibration gas for an F-940 or F-950 would include 

the following (Note, these are Air Liquide’s unique product numbers): 

Part Number: A0909352 Scotty 34 

Description: 2 Component Mix, Balance Air, Gas 34, NR 

  AIR  BAL 

  ETHYLENE 1.5 PPM 

Phase: Cylinder Gas Measurement: Mole Class: N/A 

Size: 34  

Your gas vendor will do their best to meet your specified 

concentration and will provide a certificate of analysis with your 

http://www.airliquide.com/
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gas showing what they have delivered. Be certain to use the actual value on the certificate of analysis as 

it may differ from what you have ordered. 

If you don’t already own a regulator, you must buy one. The following is the ordering information  for 

the on-demand style regulator that we typically use. (Note, these are Air Liquide’s unique product 

numbers) 

Part Number: A0315576 

Description: Q114DRFRC10 – M14 Demand Regulator 

0 – 3 LPM @ 3’ 
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F-900 Production Test Check Sheet 
 

SERIAL NUMBER:  

Firmware Version:  

 

 

 

Optional Sensors Included (Yes/No) 

C02 PPM  

CO2 PCT  

O2 PCT  

 

 

CALIBRATION PARAMETERS  C2H4 PPB C2H4 PPM 

Internal offset   

Internal gain   

Calibration RH   

Calibration T   

RH slope   

RH offset   

T slope    

T offset   

 

Optional Sensors 
CALIBRATION PARAMETERS  CO2 PPM CO2 PCT 

Zero    

Span   

Calibration T   

 

 

CALIBRATION PARAMETERS  O2 

Internal offset  

Internal gain  

Calibration RH  

Calibration T  

 

Internal Volume (with 

optional sensors) 

 

 

NOTES:                                                                                                                                              
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Warranty Information 
 

Seller's Warranty and Liability: 
  
Felix Instruments- Applied Food Science warrants new equipment of its own manufacturing 
against defective workmanship and materials for a period of one year from date of sale. The 
results of ordinary wear and tear, neglect, misuse, accident and excessive deterioration due to 
corrosion from any cause is not to be considered a defect.  
Felix Instruments’ liability for repairing or replacing defective parts during the warranty period 
is contingent on examination by a Felix Instruments authorized representative. Felix 
Instruments liability will not extend beyond repairing or replacing parts from the factory where 
they were originally manufactured. Repair or alteration by an unauthorized technician voids 
warranty.  
Material and equipment which is not manufactured by Felix Instruments is to be covered only 
by the warranty of its manufacturer. Felix Instruments will not be liable to the Buyer for loss, 
damage, or injury to persons or to property by the use of equipment manufactured by other 
companies.  
 
 
Buyer accepts the terms of warranty through use of this instrument and any accessory 
equipment. There are no understandings, representations, or warranties of any kind, express, 
implied, statutory, or otherwise (including, but without limitation, the implied warranties of 
merchantability and fitness for a particular purpose), not expressly set forth herein. 
 
 
All instrument repairs or replacement covered under warranty require a Returned Material 
Authorization (RMA) number. Please contact Felix Instruments technical support department at 
support@felixinstruments.com to obtain an RMA number before shipping instrument to CID 
Bio-Science, Inc.  
 
Buyer is responsible for shipping charges to Felix Instruments headquarters: 
 
1554 NE 3rd Ave. 
Camas, WA 98607 
USA 
 
 
Felix Instruments is responsible for return shipping charges on repairs and/or replacement 

covered by warranty. 
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